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Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as
well as to protect the product and connected equipment. These notices are highlighted in the
manual by a warning triangle and are marked as follows according to the level of danger:

Danger
Danger indicates an imminently hazardous situation which, if not avoided, will result in death or
serious injury.

Warning
Warning indicates a potentially hazardous situation which, if not avoided, could result in death or
serious injury.

Caution
Caution used with the safety alert symbol indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

Caution
Caution used without the safety alert symbol indicates a potentially hazardous situation which, if
not avoided, may result in property damage.

Notice
Notice indicates a potential situation which, if not avoided, may result in an undesirable result or
state.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified
persons are defined as persons who are authorized to commission, to ground, and to tag circuits,
equipment, and systems in accordance with established safety practices and standards.

Correct Usage
Note the following:

Warning
This device and its components may only be used for the applications described in the catalog
or the technical descriptions, and only in connection with devices or components from other
manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and
installed correctly, and operated and maintained as recommended.

Trademarks
SIMATIC , SIMATIC HMI and SIMATIC NET are registered trademarks of SIEMENS AG.

Some of the other designations used in these documents are also registered trademarks; the owner’s rights may
be violated if they are used by third parties for their own purposes.

We have checked the contents of this manual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot
guarantee full agreement. However, the data in this manual are reviewed regularly
and any necessary corrections included in subsequent editions. Suggestions for
improvement are welcomed.

Disclaimer of LiabilityCopyright Siemens AG 2005 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for damages.
All rights, including rights created by patent grant or registration of a utility model
or design, are reserved.

Siemens AG
Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

Siemens AG 2005
Technical data subject to change.

Siemens Aktiengesellschaft
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Preface
Purpose of the manual

The SIMATIC Text Display (TD) User Manual is a combination user and reference manual that
describes the operation of the TD devices (TD 100C, TD 200C and TD 200) with an S7-200 CPU.

Required Basic Knowledge
This manual is designed for engineers, programmers, and maintenance personnel who have a
general knowledge of programmable logic controllers and operator interfaces.

Scope of This Manual
This manual describes the installation, configuration and operation of the TD 100C version 1.0,
the TD 200 version 3.0, and the TD 200C version 1.0. This manual also describes the Text
Display wizard of STEP 7--Micro/WIN (used to configure the S7-200 CPU for the TD devices) and
the Keypad Designer application (used to configure the keypad of the TD 100C and the
TD 200C).

To utilize these TD devices, you must use the following:

STEP 7--Micro/WIN version 4.0 SP2 or greater for TD 100C version 1.0

STEP 7--Micro/WIN version 4.0 or greater for TD 200C version 1.0 and TD 200 version 3.0

Agency Approvals
These SIMATIC TD devices meet the standards and regulations of the following agencies.

Underwriters Laboratories, Inc.(UL): UL 60950 for the TD 200C and TD 200, and UL 508,
UL 1604 for the TD 100C

Canadian Standards Association: CSA C22.2 No. 60950 standard for the TD 200C and TD
200, and CS22.2 No. 142 standard and CSA--213 for the TD 100C

Refer to Appendix A for additional compliance information.

Certification
These SIMATIC TD devices have the following certification:

Underwriters Laboratories (UL) Standards

TD 200C, TD 200: UL 60950 and CSA C22.2 No. 60950

TD 100C: UL 508 and CS22.2 No. 142; UL 1604 and CSA--213

Factory Mutual Research: Standard Class Number 3611, Class I, Division 2, Group A, B, C,
D, and Class I, Zone 2, Group IIC.

Temperature class T5 is adhered to when the ambient temperature during operation does
not exceed 60°C.

CE Labeling
These SIMATIC TD devices fulfill the requirements and protection guidelines of the following EU
directives:

EC Directive 94/9/EC “ATEX directive”

EC Directive 89/336/EEC “EMC directive”

C--Tick
These TD devices are compliant with requirements of the AS/NZS 3548 (Australian) standard.
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Recycling and Disposal
Please contact a company certified in the disposal of electronic scrap for environmentally safe
recycling and disposal of your device.

Place of this Document in the Information Environment
Product
Family Documentation Order Number

S7-200 SIMATIC Text Display (TD) User Manual
(resides on the STEP 7--Micro/WIN documentation CD)

Not applicable

Simplified Chinese Character Set
(resides on the STEP 7--Micro/WIN documentation CD)

Not applicable

S7-200 S7-200 Programmable Controller System Manual 6ES7 298--8FA24--8BH0

Finding Your Way
If you are a first-time (novice) user of TD devices, you should read the entire SIMATIC Text
Display (TD) User Manual. If you are an experienced user, refer to the table of contents or index to
find specific information.

The SIMATIC Text Display User Manual is organized according to the following topics:

Chapter 1 (Product Overview) provides an overview of the TD devices

Chapter 2 (Installing Your TD Device) provides installation instructions and guidelines.

Chapter 3 (Using the Keypad Designer to Create a Custom Faceplate for Your TD Device)
provides information about the Keypad Designer and the steps required for configuring the
keypad and faceplate for the TD 100C and the TD 200C.

Chapter 4 (Using the Text Display Wizard to Configure the S7-200 CPU for Your TD Device)
provides information about using the Text Display wizard of STEP 7--Micro/WIN to configure
the S7-200 CPU for the TD device.

Chapter 5 (Operating Your TD Device) provides information about the basic operation of the
TD devices and also describes the features and capabilities.

Appendix A (Technical Specifications and Reference Information) provides the technical
information for the TD devices and also provides references for the character sets
supported.

Appendix B (Connecting Multiple Devices on a Network) provides information about using a
TD device in a network with other TD devices and S7-200 CPUs.

Appendix C (Troubleshooting) provides information to help you diagnose problems with the
TD device.

The Simplified Chinese Character Set shows the characters supported by the TD devices. This
file is an electronic file and resides on the STEP 7--Micro/WIN documentation CD.
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Additional Support

Local Siemens Sales Office or Distributor
For assistance in answering any technical questions, for training on the S7-200 products, or for
ordering S7-200 products, contact your Siemens distributor or sales office. Because your sales
representatives are technically trained and have the most specific knowledge about your
operations, process and industry, as well as about the individual Siemens products that you are
using, they can provide the fastest and most efficient answers to any problems that you might
encounter.

Service & Support on the Internet
In addition to our documentation, we offer our Know-How online on the internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

Access the S7-200 Internet site to find additional S7-200 product information:

www.siemens.com/S7--200

This site includes frequently asked questions (FAQs), Programming Tips (application
examples and sample programs), information about newly released products, and product
updates or downloads

Read the newsletter, which constantly provides you with up-to-date information on your
products

Use the Search feature of the Service & Support area to find specific documentation

Share information and exchange experiences with a forum of other users and experts from
all over the world

Find your local Siemens representative for Automation & Drives

Use the “Services” link to find information on field service, repairs, spare parts and more

Technical Services
The highly trained staff of the S7-200 Technical Services center is also available to help you solve
any problems that you might encounter. You can call on them 24 hours a day, 7 days a week.
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A&D Technical Support

Worldwide, available 24 hours a day:

Johnson City

Nuremberg

Beijing

Technical Support

Worldwide (Nuremberg)

Technical Support

24 hours a day, 365 days a year

Phone: +49 (180) 5050-222

Fax: +49 (180) 5050-223

E--Mail:
adsupport@siemens.com

GMT: +1:00

United States (Johnson City)

Technical Support and
Authorization
Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone: +1 (423) 262 2522

+1 (800) 333--7421 (USA only)

Fax: +1 (423) 262 2289

E--Mail:
simatic.hotline@sea.siemens.com

Asia / Australia (Beijing)

Technical Support and
Authorization
Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone: +86 10 64 75 75 75

Fax: +86 10 64 74 74 74

E--Mail:
adsupport.asia@siemens.com
GMT: +8:00

Europe / Africa (Nuremberg)

Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone: +49 (180) 5050--222

Fax: +49 (180) 5050-223

E--Mail:
adsupport@siemens.com
GMT: +1:00

simatic.hotline@sea.siemens.com
GMT: --5:00

GMT: +8:00

The languages of the SIMATIC hotlines and the authorization hotline are generally German and English.
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Product Overview

The S7-200 TD devices provide a low-cost human-machine interface (HMI), allowing an operator
or user to interact with your application.

The TD devices allow you to configure a set of hierarchical user menus to provide additional
structure for the interaction with your application. You can also configure the TD device to display
alarms or messages that are enabled by specific bits in the S7-200 CPU.

Tip
The TD devices provide additional functionality, such as the hierarchical user-defined menus.
The TD 200C and the TD 200 are fully compatible with projects that were created with earlier
versions of the TD 200 (prior to TD 200 V3.0, which supported only the bit-enabled messages
from the S7-200 CPU).

You can use the TD 200C or the TD 200 device with an existing TD configuration without having
to modify the control program in the S7-200 CPU.

The TD 100C is not compatible with the TD 200 devices.
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Introducing the S7-200 Text Display (TD) Devices
Your S7-200 TD device is a 2- or 4-line text display device that can be connected to the
S7-200 CPU. The TD device allows you to view, monitor, and change the process variables
pertaining to your application.

The S7-200 product family provides three TD
devices:

TD 100C: The TD 100C has a 4-line text
display with 2 font choices. Your display
can have 16 characters per line for a total
of 64 characters, or you can use a bold font
with 12 characters per line for a total of 48
characters. The faceplate of the TD 100C
offers complete flexibility of the keypad
layout and faceplate design.

You can create a custom keypad with up to
14 buttons (keys) of variable size, with
varying shapes, colors, or fonts that can be
layered onto any background image.

TD 200C: The TD 200C has a 2-line text
display with 20 characters per line for a
total of 40 characters. The faceplate of the
TD 200C offers complete flexibility of the
keypad layout and faceplate design.

You can create a custom keypad with up to
20 buttons (keys) of variable size, with

TD 200C

TD 200

TD 100C

( y ) ,
varying shapes, colors, or fonts that can be
layered onto any background image.

Figure 1-1 Text Display (TD) Devices

TD 200: The faceplate of the TD 200 provides four keys with predefined, set-bit functions
and allows up to eight set-bit functions by using the SHIFT key.

The TD devices receive power from the S7-200 CPU through the TD/CPU cable. The TD 200C
and TD 200 devices can also receive power from a separate power supply.

The TD devices contain the following elements:

Text display area: The TD 200C and TD 200 has a backlit liquid crystal display (LCD) with a
resolution of 33 x 181 pixels. The TD 100C has a liquid crystal display (LCD) with a
resolution of 132 x 65 pixels.

Communication port: 9-pin D-connector

Power connector: The TD 200C and TD 200 have a connector for using an optional
external power supply (power for the TD device is typically supplied by the S7-200 CPU
through the TD/CPU cable). The TD 100C does not have the option of using an external
power supply.
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STEP 7--Micro/WIN provides tools to help you configure the TD devices. Using the following tools,
you can easily program your S7-200 to display text messages and other data:

Text Display wizard helps you configure messages for the TD devices.

Keypad Designer helps you to configure the custom keypad for the TD 100C and the
TD 200C. The Keypad Designer includes samples and templates in the following
directories:

-- Sample bitmaps for buttons and backgrounds:

C:/Program Files/Siemens/TD Keypad Designer/Images

-- Sample projects:

C:/Program Files/Siemens/TD Keypad Designer/Samples

-- Sample template (for printing multiple copies of the faceplate):

C:/Program Files/Siemens/TD Keypad Designer/Templates

Each TD device functions as a network master when it is connected over a network that contains
one or more S7-200 CPUs. The TD device is also designed to operate with other masters in a
network. Multiple TD devices can be used with one or more S7-200 CPUs connected to the same
network. More than one TD device can connect to the same S7-200 CPU.

Features of the TD Devices
You can use your TD device to perform the following tasks:

Viewing a hierarchy of user menus and screens that allow an operator to interact with the
application or process

You create these user menus and screens with the Text Display wizard of
STEP 7--Micro/WIN

Displaying alarms (bit-enabled messages) that are generated by the S7-200 CPU

You define these alarms with the Text Display wizard of STEP 7--Micro/WIN

Modifying designated program variables

The TD device allows you to define a variable as either a text string or a numeric string:

-- Text string: All characters in a variable are editable

-- Numeric string: Only the numeric characters are editable (the cursor skips over all
non-numeric characters)

The TD device allows you to define a variable as a word, double word, or real

Forcing or unforcing I/O points: You can force individual I/O points in the S7-200 CPU to be
on or off (TD 200C and TD 200 only)

Setting the time and date (if the S7-200 CPU supports a real-time clock)

Viewing the CPU status (including version information)

The TD 200C provides additional functionality for interacting with the S7-200 CPU:

You can change the operating mode (RUN or STOP) of the S7-200 CPU

You can load the user program in the S7-200 CPU to a memory cartridge

You can access and edit the data stored in the memory of the S7-200 CPU
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International Languages and Characters Support
The TD 200C and TD 200 devices provide a default TD character set which supports bar graph
characters. The TD 100C, TD 200C and TD 200 devices support the following Windows character
sets for displaying messages:

Arabic (TD 200C and TD 200 only)

Baltic

Chinese (Simplified Chinese)1

Cyrillic

Greek

Hebrew (TD 200C and TD 200 only)

Latin 1 (with Boldface)

Latin 2 (with Boldface)

Turkish (Latin 5)

The TD devices provide system menus and prompts in six languages: English, German, French,
Spanish, Italian, and Simplified Chinese.

In the TD 100C, all fonts except Simplified Chinese are available in two sizes: 12 and 16
characters per row. All the 12 character fonts are bold.

Table 1-1 Fonts Supported by the TD Devices

TD 100C TD 200 TD 200C

Latin 1 Latin 1 Latin 1

-- Latin 1 Bold Latin 1 Bold

Latin 2 Latin 2 Latin 2

-- Latin 2 Bold Latin 2

Cyrillic Cyrillic Cyrillic

Greek Greek Greek

Turkish Turkish Turkish

Baltic Rim Baltic Rim Baltic Rim

-- Arabic Arabic

-- Hebrew Hebrew

-- Original TD 200 Original TD 200

-- Bar Graph Bar Graph

Simplified Chinese1 Simplified Chinese Simplified Chinese

1 The TD 100C includes approximately 1900 out of the possible 6763 Chinese characters.
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Comparing the TD 100C, the TD 200 and the TD 200C

Table 1-2 Comparing the features of the TD Devices

Feature TD 100C V 1.0 TD 200 V3.0 TD 200C

Text display area 4 lines, up to 64 characters
(up to 16 characters per
line)

2 lines, up to 40 characters
(up to 20 characters per
line)

2 lines, up to 40 characters
(up to 20 characters per
line)

Keypad options User-designed custom
keypad

Standard keypad

Standard keypad User-designed custom
keypad

Standard keypad

Configurable buttons Custom keypad: Up to 14
(user-configurable)

Standard keypad: 2

Standard keypad: 4
(up to 8 when using SHIFT)

Custom keypad: Up to 20
(user-configurable)

Standard keypad: 4
(up to 8 when using SHIFT)

System buttons
(pre-configured)

ENTER, ESC (Escape), UP,
DOWN, LEFT and RIGHT
arrows, F1, F2

ENTER, ESC (Escape),
SHIFT, UP and DOWN
arrows

Configurable

ENTER, ESC (Escape),
SHIFT, UP, DOWN, LEFT,
and RIGHT arrows

User-defined menus and
user screens

Maximum of 32 screens

Up to 4 user menus, with up
to 8 screens per user menu

Maximum of 64 screens

Up to 8 user menus, with up
to 8 screens per user menu

Maximum of 64 screens

Up to 8 user menus, with up
to 8 screens per user menu

Alarms
(from the S7-200 CPU)

Up to 40 alarm messages Up to 80 alarm messages Up to 80 alarm messages

Alarm indicator (icon) Yes Yes Yes

Variables embedded in an
alarm or screen

1 per line (1 for one-line
alarms, 2 for two-line
alarms, 4 for a screen)

Up to 6 variables per alarm
or screen

Up to 6 variables per alarm
or screen

Icons (graphics)
embedded in a message

No No Yes

System menu options Release the password

Set the time and date

CPU status

Clean keypad

Force I/O

Release the password

Set the time and date

CPU status

Switch languages (if
configured)

Clean keypad

Force I/O

Release the password

Set the time and date

CPU status

Switch languages (if
configured)

Change the CPU operating
mode

Clean keypad

Edit the CPU memory

Program a memory cartridge

Password protection Yes Yes Yes

Multiple language sets No Yes Yes

Character sets supported
(for displaying different
languages)

7 character sets:
Latin 1, Latin 2, Chinese
(Simplified), Cyrillic, Baltic,
Greek, Turkish

10 character sets:
Latin 1/Bold, Latin 2/Bold,
Chinese (Simplified), Cyrillic,
Arabic, Baltic, Greek,
Hebrew, Turkish, and
Standard TD (includes Bar
Graph)

10 character sets:
Latin 1/Bold, Latin 2/Bold,
Chinese (Simplified), Cyrillic,
Arabic, Baltic, Greek,
Hebrew, Turkish, and
Standard TD (includes Bar
Graph)

Languages for system
menus and error
messages

6 languages:
English, French, German,
Italian, Spanish, and
Chinese

6 languages:
English, French, German,
Italian, Spanish, and
Chinese

6 languages:
English, French, German,
Italian, Spanish, and
Chinese

Feedback (when pressing
a button)

Visual indicator in the text
display area

Tactile dome over the
buttons on the keypad and
visual indicator

Visual indicator in the text
display area
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Using the TD Device to Access Screens and Alarms
When you configure the TD device with the Text Display wizard of STEP 7--Micro/WIN, you create
the screens and alarms for the TD device. You use the buttons on the keypad of the TD device to
navigate through the screens and menus. The TD 200 device uses the standard TD keypad. The
standard faceplates for the TD devices are shown in Figure 1-2.

The TD 100C and the TD 200C allow you to create your own custom-designed buttons with
specialized functions.

F1
F5

F2
F6

F3
F7

F4
F8

SHIFT ESC ENTER

Text display area Arrow buttons

Configurable buttons
(and SHIFT)

ENTER
and ESC

F1
F5

F2
F6

F3
F7

F4
F8

SHIFT ESC ENTER

Text display area Arrow buttons

Configurable buttons
(and SHIFT)

ENTER
and ESC

Standard Faceplate (TD 200) Standard Faceplate (TD 200C)

F1 F2 ESC ENTER

Text display area Arrow buttons

Configurable buttons
ENTER
and ESC

Standard Faceplate (TD 100C)

Figure 1-2 Standard Keypad Configuration for the TD Devices
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Dividing Information into Screens and Bit-Enabled Alarms
As shown in Figure 1-3, you can configure the TD device to display screens (which are initiated by
operator action) and bit-enabled alarms (which are initiated by the S7-200 CPU).

Screens: You can create screens that allow the operator (using the TD device) to initiate the
interaction with the S7-200 CPU. With the TD device, you can configure a user menu (up to
8 entries or groups for the TD 200C and TD 200, and up to 4 entries or groups for the
TD 100C) that provides a hierarchy for the screens. You can create up to 8 screens for
each menu item or group.

Alarms: You can create alarm messages that allow the user program in the S7-200 CPU to
initiate interaction with the operator by displaying a message on the TD device.

During the configuration of the TD device, you also designate which type of message (screens or
alarms) will be the default display mode for the TD device. After power-up, the TD device goes to
the default display mode. Also, the TD device returns to the default display mode after a period of
inactivity (if no buttons have been pressed for one minute).

Storing the Screens and Alarms in the Parameter Block
The S7-200 CPU stores the ASCII text, embedded variables, and format information for the
alarms and screens in a parameter block located in V memory. You use the Text Display wizard to
configure the starting address for the parameter block in V memory, and the Text Display wizard
allocates the memory required to store the information for the TD device.

If you configure more than one parameter block for the S7-200 CPU (with each parameter block
having a different range of addresses in V memory), you can connect several TD devices to that
one S7-200 CPU. You configure the V memory address for the specific parameter block for each
of the TD devices. The Diagnostic Menu of the TD device provides a TD Setup command for
specifying the starting address of the parameter block.

Tip
The parameter block for the TD 100C is not compatible with the parameter blocks for the
TD 200C or the TD 200.
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Displaying the Screens and Alarms on the TD Device
When the operator uses the buttons on the TD device to select a screen, the TD device reads the
screen information from the parameter block (stored in V memory of the S7-200 CPU) and
displays the appropriate screen.

When you configure an alarm, you also configure an alarm bit for enabling a specific alarm. The
logic of your user program sets this alarm bit to display the alarm on the TD device. When you
create the text for the alarm, you also designate the alarm bit. If you configured an alarm to require
acknowledgement by an operator, that alarm also has an acknowledge bit. The TD device
continuously polls the alarm bits to determine which alarms have been enabled.

To display an alarm on the TD device, your user program in the S7-200 CPU must first set the
alarm bit for the specific alarm. When your user program sets one of the alarm bits, the TD device
then reads the alarm bits in the parameter block in the S7-200 CPU and displays the
corresponding alarm message.

TD Device

Pressure High
Check Speed
Calibrate Size

Alarms

S7-200 CPU

Width:

123.4

Minimum:

123.4 psi

Length:

123.4

Height:

123.4
Change
Size

Maximum:

123.4 psi
Change
Pressure

User Menu Screens

Alarms are sorted by the sequential priority that
you created with the Text Display wizard:

The first alarm that you configured is the
highest priority

The last alarm that you configured is the
lowest priority

Refer to Chapters 4 and 5 for information about
alarms

Figure 1-3 Screens and Alarms
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Installation and Configuration Tasks
As shown in Figure 1-4, you use the Text Display wizard of STEP 7--Micro/WIN to configure the
TD device. You can create a custom faceplate for the TD 100C and TD 200C. The Keypad
Designer creates a keypad configuration file for the Text Display wizard.

Figure 1-5 and Figure 1-6 provide an overview of the tasks for installing the TD device. Refer to
Chapter 2.

TD 200

Keypad Designer
Save the keypad configuration
file (*.td2 or *.td1)

STEP 7--Micro/WIN
Text Display Wizard

Create the screens and the alarms for your
operator interface

Configure the parameter block for the
TD device (V memory in the S7-200 CPU)

Parameter Block

When you download your user program, the
S7-200 CPU stores the parameter block in
the V memory address you selected.

Laser Printer

Print the faceplate for the TD 200C
or TD 100C

S7-200 CPU

TD 2000C TD 100C

Figure 1-4 Configuration Tasks for the TD Devices
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Label Insert

TD 200 TD 200C

Install the
faceplate

Remove the
Housing

Mounting Screws

(Optional)
Modify the
Label Insert

Insert the
Spacers and
Mount the
TD 200

Spacers

To S7-200 CPU

Connect to the
S7-200 CPU

External Power
Supply (optional)

Remove the
Housing

Insert the
Spacers and
Mount the
TD 200C

Connect to the
S7-200 CPU

Mounting Screws

Spacers

To S7-200 CPU

External Power
Supply (optional)

View Messages
TD Setup

To connect your TD device to a network, use the Diagnostic Menu of
the TD device to set up the network addresses, baud rate and other
parameters.

Refer to Chapter 5

Figure 1-5 Installing Your TD Device
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TD Setup
To connect your TD 100C device to a network, use the TD Setup
Menu of the TD 100C device to set up the network addresses, baud
rate and other parameters.

Refer to Chapter 5

Install the
faceplate

Clip on the
mounting
brackets.
Tighten the
screws to

secure the TD
to the panel.

Connect to the
S7-200 CPU

To S7-200 CPU

Mounting bracket

Mounting bracket

Mounting
Screws

TD 100C

Figure 1-6 Installing Your TD 100C Device
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Creating a Custom Faceplate for The TD Device
With the TD 100C and the TD 200C, you can design a custom faceplate that incorporates buttons
(keys) of varying size, with varying shapes, colors, or fonts that can be layered onto any
background image. You use the Keypad Designer to create the custom-designed layout for the
keypad.

As shown in Figure 1-7, you use several applications to create a custom faceplate:

Keypad Designer: Creates the layout and the configuration for the keypad

Third-party graphics application: Designs the graphical appearance of the faceplate

STEP 7--Micro/WIN (Text Display wizard): Configures the parameter block for the TD 100C
and the TD 200C

Word-processing application (optional): Prints multiple copies of the faceplate

Siemens provides document files (in 6 languages) for Microsoft Word that help you to align
the panel images for the perforations on the A4 blank faceplate material. To open these
documents, browse to the Templates subdirectory under the Keypad Designer application
(C:/Program Files/Siemens/TD Keypad Designer/Templates) and select the template for
your TD device and language.

STEP 7--Micro/WIN
Text Display Wizard

Configure the
TD device

Keypad Designer
Create the layout of the buttons

Configure the functionality for
each button

Add an image for the keypad
panel

Print the faceplate for the TD
device

Create the keypad configuration
file (*.td1 for the TD 100C, or
*.td2 for the TD 200C)

Graphics
Application

(Third-Party)

Word-Processing
Application
(Optional)

Print the faceplate onto the blank
label material

Figure 1-7 Using the Keypad Designer and Other Applications to Create a Custom Faceplate
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Printing the Custom Faceplate for the TD Device
The TD 100C and the TD 200C ship with one blank faceplate (envelope-size) for printing the
faceplate. The faceplate is constructed from durable, polyester material which has been designed
especially for use on HMI faceplates.

You can print a single faceplate directly from the Keypad Designer on the envelope-sized
blank faceplate.

To print multiple faceplates, you can use the Microsoft Word template (provided in the
Templates subdirectory) that ensures your faceplate design is properly sized. You can print
multiple faceplates onto the perforated A4-size blank faceplate sheets.

Refer to Chapter 3 for specific information about printing the custom faceplate for the TD 100C or
the TD 200C.

Tip
The faceplate material is specially treated on one side to accommodate printing with a laser
printer. The treated surface is up (or toward you) when you are holding the material with the cut
corner in the top right of the sheet.

Ensure that the material is correctly inserted into the laser printer so that the faceplate prints the
reversed image onto the treated surface of the material. You must print a reversed-image
version of the faceplate onto the faceplate material.

Before printing your custom faceplate onto the blank faceplate sheet, first test your design by
printing the faceplate onto regular paper. You can then temporarily use the paper faceplate to
test the functionality of the design with your TD 100C or TD 200C.

Printer Requirements
To print your custom-designed image onto the blank faceplate material, you must use a laser
printer that supports the following features:

Paper size: The laser printer must be able to print on both the A4 (210 mm X 297 mm) and
envelope formats.

Color: The laser printer must support color printing.

Transparencies: The laser printer must support the printing of transparencies (or other
non-paper stock).

Ordering Additional Faceplate Material
You can order additional blank faceplates for your TD device in perforated A4-size sheets
(10 sheets/package). The faceplate material is especially designed for printing on a laser printer.
The blank faceplate sheets also allow you to utilize the services of professional printing vendors
that specialize in laser printing in order to create large quantities of high-quality faceplates.

Contact your local Siemens representative or distributor to purchase additional quantities of the
faceplate material. The order numbers are shown below:

For the TD 200C, the order number for additional blank faceplates is
6ES7 272--1AF00--7AA0

For the TD 100C, the order number for additional blank faceplates is
6ES7 272--1BF00--7AA0



SIMATIC Text Display (TD) User Manual

14



15

Installing Your TD Device

You can install your TD device for easy access, whether on a panel, on a door of an enclosure, or
on a wall.

Installed properly, the TD device meets the following standards for protection:

IP 65 (mounted on front of the panel)

IP 20 (mounted on casing)

NEMA 4

Refer to Appendix A for technical specification and for information about agency approvals and
other certifications.

Tip
You can use the TD 200, version 3.0 and the TD 200C, version 1.0 with an existing TD 200
configuration without having to modify the control program in the S7-200 CPU. The TD 100C is
not compatible with the TD 200 devices.

In This Chapter
Components Shipped with the TD Devices 16. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Mounting the TD 200C and TD 200 in a Panel or on a Surface 17. . . . . . . . . . . . . . . . . . . . . . .

Preparing the Mounting Surface for a TD 200C or TD 200 17. . . . . . . . . . . . . . . . . . . . . . .

Preparing the TD 200C and TD 200 for Mounting 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Positioning the Spacers for the TD 200C and TD 200 17. . . . . . . . . . . . . . . . . . . . . . . . . . .

Mounting the TD 200C and TD 200 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Mounting the TD 100C in a Panel or on a Surface 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Preparing the Mounting Surface for a TD 100C 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Mounting the TD 100C 18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Customizing the Labels for the Keys of the TD 200 19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Modifying the Label Insert of the TD 200 19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Creating a Custom Label Insert for the TD 200 19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Installing a Faceplate for the TD 100C and the TD 200C 20. . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Connecting the TD/CPU Cable 21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Supplying Power for the TD Device 22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Establishing a Connection for Your TD Device 23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TD 100C and TD 200C 23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Components Shipped with the TD Devices
The TD devices ship with the following components:

Gasket: Protective cushion with gasket for installing the TD device in inclement
environments

TD/CPU cable: 9-pin, straight-through cable that provides both communication and power
to the TD device.

If the TD 100C is purchased outside North America, the cable must be ordered separately.
The TD 100C, if purchased in North America includes the TD/CPU cable. The order number
for the TD/CPU cable is 6ES7--901--3EB10--0XA0.

Spacers: Self-adhesive spacers for mounting the TD device in a panel (TD 200C and
TD 200 only)

Mounting brackets: Brackets for mounting the TD device in a panel (TD 100C only)

The TD 200 ships with a pull-out user label that allows you to label the function keys for your
application.

The TD 100C and the TD 200C ship with a blank faceplate that you can customize and a
pre-printed faceplate for the standard TD keypad. The faceplate is constructed from durable,
polyester material which has been designed specifically for use for HMI faceplates.

Tip
To print your custom-designed image onto the blank faceplate material, you must use a laser
printer that supports the printing of transparencies on both A4 and envelope formats and also
supports color printing.

General TD Installation Information

Tip
To ensure compliance with IP 65 and NEMA 4:

The minimum panel thickness must be at least 1.5 mm.

The mounting screws on the TD device must be tightened to a torque of 0.7 N--m.

The gasket must be replaced whenever the TD device is removed and reinstalled.

To procure new gaskets, contact your Siemens distributor or sales representative.

This equipment is suitable for use in Class I, Division 2, Groups A, B, C, D; Class I, Zone 2,
Group IIC; or non-hazardous locations.

Warning
WARNING -- EXPLOSION HAZARD!

DO NOT DISCONNECT WHILE CIRCUIT IS LIVE UNLESS LOCATION IS KNOWN TO BE
NON-HAZARDOUS

Warning
WARNING -- EXPLOSION HAZARD!

Substitution of components may impair suitability for Class I, Division 2 or Zone 2.
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Mounting the TD 200C and TD 200 in a Panel or on a Surface

Tip
If you are using a customized label insert for your TD 200 device, you must first install the new
label insert before you mount the TD device.

Preparing the Mounting Surface for a TD 200C or TD 200

To prepare the surface where the TD 200C or
TD 200 is to be mounted or installed:

Cut a 138 mm x 68 mm hole in the mounting
surface (DIN 43700). See Figure 2-1.

Refer to Table A-1 for the outside
dimensions of the TD 200C or TD 200
device.

138 mm

68 mm

Figure 2-1 Dimensions for Cutting a Hole in the
Mounting Surface of the TD 200C
and TD 200

Preparing the TD 200C and TD 200 for Mounting

Refer to Figure 2-2 and use the following
procedure to separate the front cover from the
housing of the TD 200C and TD 200 :

1. Use a flat-head screwdriver or a T8 Torx
screwdriver to remove the three screws from
the rear of the TD device.

2. Remove the front cover of the TD device
f

Mounting Screws

from the housing. Figure 2-2 Removing the Mounting Screws of
the TD 200C and TD 200

Positioning the Spacers for the TD 200C and TD 200
The self-adhesive spacers (included with the TD 200C and TD 200) maintain the pressure on the
TD device circuit board when the TD device is assembled. The number of spacers required is
dependant upon the thickness of the mounting surface.

Refer to Figure 2-3 and use the following
procedure to position the spacers:

1. Determine the number of spacers
required, based on the thickness of
the panel:

-- For up to 1.5 mm, use one
spacer.

-- For 1.5 mm to 4.0 mm, use two
spacers.

2. Place the spacers over the screw
holes on the inside of the backplate.

Backplate

Front Cover Cabinet Door or Control Panel

Gasket
Spacers

Mounting Screws

Gasket

p

Figure 2-3 Positioning Spacers on the TD 200C and
TD 200
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Mounting the TD 200C and TD 200
Refer to Figure 2-3 and use the following procedure to complete the mounting of your TD 200C
and TD 200:

1. Remove the gasket from the protective cushion.

2. Place the supplied gasket on the frontplate of the TD device.

3. Install the spacers (if required).

4. Fit the frontplate into the cutout you made in the mounting surface.

5. Secure the backplate onto the frontplate of the TD device using the screws you removed
from the backplate. Carefully tighten the screws until snug.

Mounting the TD 100C in a Panel or on a Surface

Preparing the Mounting Surface for a TD 100C

To prepare the surface where the TD 100C is to be
mounted or installed:

Cut a 69 mm x 82 mm hole in the mounting
surface (DIN 43700). See Figure 2-4.

Refer to Table A-1 for the outside
dimensions of the TD 100C device.

69 mm

82mm

Figure 2-4 Dimensions for Cutting a Hole in the
Mounting Surface of the TD 100C

Mounting the TD 100C
Refer to Figure 2-5 and use the following procedure to complete the mounting of your TD 100

1. Remove the gasket from the protective
cushion.

2. Place the supplied gasket on the frontplate
of the TD device.

3. Fit the TD 100C into the cutout you made in
the mounting surface.

4. Attach the special mounting brackets
(included) to the TD 100C.

5. Tighten the mounting screws on the
mounting brackets to secure the TD 100C to

Mounting bracket

Mounting bracket

Mounting
Screws

Cabinet Door or Control Panel

mounting brackets to secure the TD 100C to
the panel. Figure 2-5 Mounting the TD 100C
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Customizing the Labels for the Keys of the TD 200
The TD 200 allows you to define the functions for four of the nine keys (or buttons) on the
standard faceplate. You can remove the label insert of the TD 200 and designate the functions
assigned to those user-defined keys. You can also replace the standard TD 200 insert with your
own custom insert for the user-defined keys.

You must remove (at least partially) the TD housing in order to access the label insert from
underneath the front cover of the TD device.

Modifying the Label Insert of the TD 200
1. Remove the three screws on the back of the TD device and remove the front cover from the

housing.

2. Remove the label insert by pulling the
label insert tab out of the label slot with
a pair of pointed tweezers.

3. Turn the label insert over and create
your own label design. (The reverse
side of the label insert is blank.)

4. Insert the label by placing the corner of
the label into the label slot.

5. Reinstall the front cover into the back
housing.

6. Replace and tighten the three screws
on the back of the TD device to ensure
that the cover and housing are secure.

Use tweezers to grasp the tab of the label insert

Tab of label insert

Figure 2-6 Removing the Label Insert

Creating a Custom Label Insert for the TD 200
Figure 2-7 provides the dimensions for creating your own custom label insert. These dimensions
are valid for TD 200, hardware revision 3 and later.

29.4 mm

14.2 mm

15.2 mm

29.4 mm

Material thickness 0.18 mm

17.2 mm

12.2 mm

0 mm

12.2 mm
19.15 mm

77.55 mm

0 mm

12.2 mm
19.15mm

32.15 mm
41.85 mm

54.85 mm
64.55 mm

77.55 mm
87.25 mm

100.25 mm

Window on the faceplate that allows
you to add text for your TD 200

101.6 mm

101.6 mm

1.2 mm

28.2 mm

0 mm

29
.4
m
m

Figure 2-7 Dimensions for a Custom Label Insert
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Installing a Faceplate for the TD 100C and the TD 200C
The TD 100C and TD 200C ship with a blank faceplate
(envelope size) for creating a custom-designed
faceplate.

These TD devices do not ship with the faceplate
attached. The front of the TD is an adhesive surface
(shipped with a protective paper) that allows you to
attach your custom faceplate.

Refer to Chapter 3 for information about designing and
printing a custom faceplate.

The upper diagram of Figure 2-8 shows the dimensions
for the faceplate of the TD devices. Blank faceplate
material is available in two sizes:

Envelope size for printing a single faceplate

A4 size (210 mm x 297 mm) for printing multiple
copies of the faceplate

You must cut the faceplate from the envelope-sized
material, but the A4 material is perforated to allow you
to remove the faceplates without cutting.

Use the following procedure to install your custom
faceplate on the TD device. The example shown here
is for the TD 200C. Installing a faceplate on a TD 100C
is similar; the differences are noted below.

1. Remove the blue protective film covering the
display window of the TD device and the back of
the preprinted (standard) faceplate.

2. As shown in Figure 2-8, remove the strip of
protective paper on the left side of the TD 200C
to expose a strip of the adhesive. For the
TD 100C, this strip is on the right side of the
device.

3. Carefully align your custom faceplate on the
entire TD 200C, and then seal the faceplate to
the exposed adhesive by pressing down on the
left side of the faceplate. For the TD 100C, press
down on the right side of the faceplate.

4. Carefully lift back the unadhered faceplate and
remove the rest of the protective paper from the
TD device.

5. Carefully position the faceplate onto the
TD device. Firmly press the faceplate onto the
adhesive as shown in Figure 2-8, taking care to
remove any air bubbles that may have been
trapped underneath.

4

2

3

5

Dimensions for the Custom Faceplate

65.7 mm TD 200C
65.8 mm TD 100C

137.7 mm TD 200C
79 mm TD 100C

Custom Faceplate

Figure 2-8 Installing a Custom Faceplate
on a TD Device
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The standard TD faceplates are shown in Figure 1-2. The TD 200C comes configured as a
standard TD 200 (with LEFT and RIGHT arrows). The TD 100C comes configured with six
standard keys (UP, DOWN, LEFT and RIGHT arrows, ESC, and ENTER).

After creating and installing the custom faceplate on your TD device you must also download the
TD configuration that you created with both the Keypad Designer and the Text Display wizard.

Chapter 3 describes the Keypad Designer

Chapter 4 describes the Text Display wizard

Connecting the TD/CPU Cable

Caution
Operating the TD device with an ungrounded voltage source can damage the TD device.

The TD device may only be connected to grounded voltage sources. Non-grounded operation
can cause the TD device to become damaged.

Always ensure that the voltage source for the TD device is properly grounded.

The TD devices can use the TD/CPU cable for communicating with the S7-200 CPU.

You can connect the TD device directly to the S7-200 CPU, creating a one-to-one network
configuration. In this configuration, one TD device connects to one S7-200 CPU through the
TD/CPU cable.

You can connect multiple TD devices to multiple S7-200 CPUs over a network. The
TD device defaults to address 1 and attempts to communicate to a CPU at address 2.

For more information about connecting to multiple CPUs, see Appendix B. For information
about changing the default addresses in the TD device, see Chapter 5.

If you require a longer cable (>2.5 m) to connect the TD device to the S7-200 CPU, use
PROFIBUS components for the network connection. Refer to the SINEC IK10 Catalog.
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Supplying Power for the TD Device
The S7-200 CPU uses the TD/CPU cable to provide power to the TD device. Use this type of
power supply when the distance between the TD device and the S7-200 CPU is less than 2.5 m
(the length of the TD/CPU cable). The TD 200C and the TD 200 have the option of using an
external power supply.

Tip
The TD 100C device must use the TD/CPU cable to provide power from the S7--200 CPU to the
TD device. The TD 100C does not have the option of using an external power supply.

Tip
If the distance between the TD 200C or TD 200 and the S7-200 CPU is greater than 2.5 m, use
an external 24 VDC power supply.

If you require a longer cable (greater than 2.5 m) to connect the TD device to the S7-200 CPU,
use PROFIBUS components for the network connection. Refer to the SINEC IK10 Catalog.

Refer to Appendix B for information about using the TD device on a network.

As shown in Figure 2-9, the TD device provides up to two options for providing power:

The TD/CPU cable allows the S7-200
CPU to provide power to the TD device
over the communications port. This is the
only option available for the TD 100C.

For information about the TD/CPU cable
and the communications port, refer to
Appendix B.

You can connect the TD 200C or the
TD 200 to an external power supply.

The TD 200C or TD 200 requires 120 mA
at 24 VDC to operate. An optional power
connector is provided with the TD 200C

+24 VDC0V

Connector for an external power supply
(TD 200C and TD 200 only)

Communications port

connector is provided with the TD 200C
and the TD 200. Figure 2-9 Connecting Power to the TD Device
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Establishing a Connection for Your TD Device
As described in Chapter 4, you use the Text Display wizard of STEP 7--Micro/WIN to configure the
screens, alarms, languages, and custom keypad layout for the TD 100C and the TD 200C. The
S7-200 CPU stores this information in a parameter block (V memory).

The TD devices ship with a default configuration
and are set to communicate at a rate of 9600 baud.
The TD devices must communicate with the
S7-200 CPU to be able to read the parameter
block.

You must configure your TD device to
communicate at the same baud rate as your
S7-200 CPU.

TD 100C and TD 200C
Until the TD 100C or TD 200C successfully
connects to the S7-200 CPU and reads the
parameter block, the TD device remains configured
for the standard TD keypad shown in Figure 2-10.

To change the baud rate of your TD device, you
use the ESC and ENTER buttons to navigate to
the Diagnostic/TD Setup Menu and change the
TD Setup parameters. (See Chapter 5.) Because
the TD 100C and TD 200C ship with no faceplate
attached, it may be difficult to consistently press
ESC or ENTER.

The TD 100C and TD 200C ship with a faceplate
for the standard TD keypad. In addition, the
Keypad Designer provides a sample faceplate for
the standard TD keypad in the following directory:

C:/Program Files/Siemens/
TD Keypad Designer/Templates

For temporary use, you can print this faceplate
onto paper and lay the paper on top of the
TD device (without removing the covering from the
adhesive).

Refer to Chapter 3 for information about opening
the Keypad Designer and printing a faceplate.

F1
F5

F2
F6

F3
F7

F4
F8

SHIFT ESC ENTER

Text display area Arrow buttons

Configurable buttons
(and SHIFT)

ENTER
and ESC

F1 F2 ESC ENTER

Text display area Arrow buttons

Configurable
buttons

ENTER
and ESC

TD 200C

TD 100C

yp g p g p
Figure 2-10 Standard TD Keypad for the

TD 200C and TD 100C

Tip
On an initial setup for the TD 100C or TD 200C, use the default keypad template shipped with
the device to configure baud rates and addresses. Once the TD device has communicated to
the CPU, the TD device will use the custom keypad configuration.

Tip
If you are using a custom keypad that does not support the ENTER and ESC buttons, you must
use the standard keypad to set up the TD device.

To restore the standard TD keypad:

1. Power down the TD device

2. Press and hold the lower right corner (where ENTER key is located on the standard
keypad)

3. Power up the TD device

The default keypad is restored until the TD device is power cycled again.
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Using the Keypad Designer to Create
a Custom Faceplate for Your TD Device

With the TD 100C and the TD 200C, you can design a custom keypad that incorporates buttons
(keys) of varying size, with varying shapes, colors, or fonts that can be layered onto any
background image. You can configure up to 14 buttons on the TD 100C and up to 20 buttons on
the TD 200C.

The Keypad Designer application allows you to create a custom-designed layout for the keypad of
the TD 100C and TD 200C, and also includes samples and templates in the following directories:

Sample bitmaps for buttons and backgrounds:

C:/Program Files/Siemens/TD Keypad Designer/Images

Sample projects:

C:/Program Files/Siemens/TD Keypad Designer/Samples

Templates (for printing multiple copies of the faceplate):

C:/Program Files/Siemens/TD Keypad Designer/Templates

This chapter guides you through the tasks required for creating the layout for the keypad, creating
the configuration file for the keypad, and printing the faceplate for the TD 100C and the TD 200C.

You use the configuration file when you are configuring the TD 100C and the TD 200C with the
Text Display wizard of STEP 7--Micro/WIN. Refer to Chapter 4 for information about the Text
Display wizard.

In This Chapter
Using the Keypad Designer with Other Applications 26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Starting the Keypad Designer 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Adding Buttons to the Keypad 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Inserting a Button 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Modifying the Shape of a Button 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Defining the Properties of the Button 30. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Exporting the Keypad Layout to a Graphics Application 32. . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Adding a Panel Image to the Faceplate 33. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Importing a Panel Image 33. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Saving the Keypad to a TD Configuration File 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Reversing the Panel Image 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Printing the Panel Image on a Faceplate 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Using the Keypad Designer with Other Applications
Use the Keypad Designer to create the custom-designed layout for the keypad that incorporates
buttons or keys of varying size, with varying shapes, colors, or fonts that can be layered onto any
background image. With the TD 200C you can configure up to 20 buttons; with the TD 100C you
can configure up to 14 buttons. As shown in Figure 3-1, you use several applications to create a
custom keypad:

Keypad Designer: Creates the layout and the configuration for the keypad

Third-party graphics application: Designs the graphical appearance of the faceplate

STEP 7--Micro/WIN (Text Display wizard): Configures the parameter block for the TD device

Word-processing application (optional): Prints multiple copies of the faceplate

Siemens provides document files (in 6 languages) for Microsoft Word that help you to align
the panel images for the perforations on the A4 blank faceplate material.To open these
documents, browse to the Templates subdirectory under the Keypad Designer application
(C:/Program Files/Siemens/TD Keypad Designer/Templates) and select the template for
your TD device and language.

STEP 7--Micro/WIN
Text Display Wizard

Configure the
parameter block for
the TD device

Keypad Designer
Create the layout of the buttons

Configure the functionality for
each button

Add an image for the keypad
panel

Print the faceplate for the
TD device

Create the keypad configuration
file (*.td1 or *.td2)

Graphics
Application

(Third-Party)

Word-Processing
Application
(Optional)

Print the faceplate onto the
blank label material

Figure 3-1 Using the Keypad Designer to Create the Custom Faceplate for Your TD Device
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As shown in Figure 3-2, you perform the following tasks when designing a custom keypad:

You use the Keypad Designer to define the layout and the functions for the buttons.

You export the button template to a third-party graphics application. You then create the
panel image by designing the graphical representations for the buttons and the background
for the faceplate.

After you import the panel image into the Keypad Designer, you print the faceplate for the
TD device.

You use the Keypad Designer to create the configuration file (*.td2 for the TD 200C, or *.td1
for the TD 100C).

Keypad Designer

Create the layout for the keypad:
Add the buttons to the keypad grid

Adjust the size and location of the
buttons

Configure the functionality for the
buttons

Print the completed faceplate:
Single copies can be printed
from the Keypad Designer

Use a word-processing
application (Export the panel
image to a file)

Save the keypad configuration
file (*.td2 or *.td1)

Word-Processing Application
(Optional)

Print the faceplate onto the
blank faceplate material:

Use the template for
Microsoft Word (optional)

Set up the printer for the
correct paper size

Print the faceplate

Third-Party
Graphics Application

Design the graphics for the
faceplate:

Design the background for
the panel image

Design the button images

Add text for the buttons

Save the file as a bitmap
(*.bmp)

STEP 7--Micro/WIN
Text Display Wizard

Select the keypad configuration file
(*.td1 or *.td2) when configuring the
TD device with Text Display Wizard

Create the panel image for the
keypad:

Export the button template to a
third-party graphics application

Import the completed panel image
to the Keypad Designer

Laser Printer

Figure 3-2 Tasks for Creating a Custom Faceplate
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Starting the Keypad Designer
You use the Keypad Designer application to create a custom-designed layout for the keypad of
the TD 100C or the TD 200C.

When you install STEP 7--Micro/WIN, you also install the Keypad Designer application. The
Keypad Designer does not require STEP 7--Micro/WIN.

You can start the Keypad Designer either from within STEP 7--Micro/WIN or as a stand-alone
application:

To start as a stand-alone application: Select the Start > SIMATIC > TD Keypad Designer
menu command

To start from STEP 7--Micro/WIN: Click the Keypad Designer icon in the Tools window

The Keypad Designer application opens
with a blank keypad template shown in
Figure 3-3. Select File > New to create a
new keypad layout for either the TD 100C
or the TD 200C. In the Keypad Designer
Type dialog, select the keypad type.

To open an existing project, select the
File > Open menu command and browse
to the project.

Figure 3-3 Keypad Template

If you open a file with different target (for
example, you are working on a TD 200C
file, and you open a TD 100C file), the
panel workspace resizes for the new
target. Since the application is sized
based on the panel workspace, you may
have to resize and re-position your
application framework.

Table 3-1 describes the files that are used
by the Keypad Designer.

You can change the language of the
Keypad Designer by selecting the Tools >
Options menu command. You select the
language from the Options dialog shown
in Figure 3-4.

Figure 3-4 Options Dialog

Table 3-1 Files Used by the Keypad Designer

File Type / Command Extension Description

TD file

Open, Save, Save As

*.td2 (TD 200C)
or
*.td1 (TD 100C)

Create the Keypad project file that stores the configuration
data for the custom-designed keypad (used by the Text
Display wizard)

Button Template

Export

*.bmp Export the layout of the buttons on the keypad to a graphics
application by selecting a file

Panel Image

Import

*.bmp Import the finished bitmap of the faceplate from the graphics
application by selecting a file

Panel Image

Export (Optional)

*.bmp Export the finished faceplate to a word-processing application
for printing multiple copies of the faceplate
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Adding Buttons to the Keypad
The TD 100C and TD 200C allow you relative freedom when designing your keypad:

You can configure up to 20 buttons for the
TD 200C, and up to 14 buttons for the
TD 100C on the TD keypad .

You can vary the size and the location of
the buttons.

You can define the functionality for each
button.

The Keypad Designer provides a grid that aligns
the location of the buttons with the physical

Keypad Designer

Create the layout for the keypad:
Add the buttons to the keypad grid

Adjust the size and location of the
buttons

the location of the buttons with the physical
keypad of the TD device. Figure 3-5 Adding the Button to the Keypad

Tip
Typically, your keypad design should always include buttons with the following functions: Enter,
Escape, Up Arrow, and Down Arrow. These functions allow you to access the pre-configured
menus and functions of the TD device.

Inserting a Button
To add a button to the keypad grid:

1. Click the Draw Button icon.

2. Move the cursor over the grid.

3. Move the cursor (and button) into
position on the keypad grid.

4. Hold down the left mouse button
and drag the cursor to adjust the
size and shape of the button.

5. Release the mouse button to insert
the button onto the keypad. Figure 3-6 Adding a Button

After you have inserted the button onto the keypad grid, you can relocate the button by dragging it
to a new location on the grid. However, you cannot resize the button.

Modifying the Shape of a Button
The Keypad Designer provides two methods for modifying the shape of a button:

Changing the size or shape of a button by adding a second button on top of the first button

Erasing a portion of the button

Extending the Shape of a Button
You cannot resize a button that has been inserted onto the keypad grid. You can, however, insert
a second button on top of the first button to create a new size for the button.

As shown in Figure 3-7, adding a second
button also allows you to create buttons of
non-rectangular shape (combining the
shapes of both buttons).

When you insert the second button,
ensure that the cursor is within the
boundaries of the first button.

Figure 3-7 Extending the Shape of a Button
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Erasing an Area of the Button
You can change the shape of the button
by clicking the Erase Button icon.

As shown in Figure 3-8, the Keypad
Designer alerts you if the shape of the
button is invalid.

To delete the entire button, select the
button and press the Delete key.

Invalid areasErasing

button and press the Delete key.
Figure 3-8 Erasing an Area of a Button

Tip
A valid button must consist of at least 4 adjacent cells, with each cell having at least 2 neighbor
cells. A neighbor cell must be left, right, or up or down from the cell. Diagonal neighbor cells are
not counted.

Defining the Properties of the Button
After you create the button, you define the function that will be performed when an operator
presses the button.

You use the Properties dialog to configure the
functionality for the button:

1. Select the button to be configured.

2. Select the Edit > Properties menu
command to display the Properties dialog.

You can also right-click the button and

Keypad Designer

Configure the functionality for the
buttons

You can also right-click the button and
select Properties from the context menu.
You can double-click the button to bring up

Figure 3-9 Defining the Properties for the Button

You can double-click the button to bring up
the Set Button Properties.

3. Select the function for the button and
provide a valid function name. Click OK.
See Figure 3-10 for an example of the
TD 200C button functions.

Table 3-2 describes the functions that you can
configure for the button. The default function is to
set a bit in the S7-200 CPU (Set PLC Bit).

Some functions can also be used in combination
with other buttons, such as SHIFT or the arrow
buttons. The Properties dialog provides
suggestions for appropriate buttons for combining
the functions.

After you configure the functions for each button
on the keypad, select the File > Save or the
File > Save As menu command to create the
configuration file (*.td2 for the TD 200C or *.td1configuration file ( .td2 for the TD 200C or .td1
for the TD 100C). Figure 3-10 Button Properties Dialog

Tip
A button that has been configured will display the button name on the button in the panel layout.
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Table 3-2 Button Properties for the TD 100C and TD 200C

Category Function Description

Navigation or
S l ti

Enter Selects a menu item or confirms a value.
Selection

Escape Exits from a menu or cancels a selection.

Up Arrow Scrolls (upwards) through menu items or increments a value that
can be edited.

Down Arrow Scrolls (downwards) through menu items or decrements a value that
can be edited.

Left Arrow Moves the cursor to the left.

Right Arrow Moves the cursor to the right.

Entering data Set Bit Sets a memory bit in the S7-200 CPU. You use the Text Display
wizard to assign the specific bit address.
For the TD 200C only, you can use this button to set two different
bits by defining the Shift button.

Shift Allows you to use one Set PLC Bit button to control two different bits
in the S7-200 CPU. (TD 200C only)

Clear Value Sets the value being entered to zero (0).

Edit V-Memory Edits a V memory location in the S7-200 CPU. You must specify the
address for the V memory at run time. (TD 200C only)

User Screens
d Al

Menu Mode Displays the standard TD menus (See Chapter 5)
and Alarms

(User menu or
Display Alarm Displays the current alarm message(s)

(User menu or
Alarms menu)

See Chapters 4

Display User
Menus

Displays the user menu.

See Chapters 4
and 5 Menu 1 Screen 0 Displays the first user screen in the first user menu.

Menu 2 Screen 0 Displays the first user screen in the second user menu.

Menu 3 Screen 0 Displays the first user screen in the third user menu.

Menu 4 Screen 0 Displays the first user screen in the fourth user menu.

Menu 5 Screen 0 Displays the first user screen in the fifth user menu. (TD 200C only)

Menu 6 Screen 0 Displays the first user screen in the sixth user menu.
(TD 200C only)

Menu 7 Screen 0 Displays the first user screen in the seventh user menu.
(TD 200C only)

Menu 8 Screen 0 Displays the first user screen in the eighth user menu.
(TD 200C only)

Setting up the
TD 200C

(O t )

CPU Status Displays the View CPU Status screen.

Reads and displays the status of the S7-200
(Operator menu)

See Chapter 5
Select Language
Set

Displays the Set Language screen, allowing you to switch between
the languages that you configured for the TD 200C. (TD 200C only)

Set PLC Time and
Date

Displays the Set Time and Date screen, allowing you to enter the
time and date.

Diagnostics

(Diagnostic Menu)

Change PLC
Mode

Displays the Change CPU Mode screen, allowing you to change the
operating mode of the S7-200. (TD 200C only)(Diagnostic Menu)

See Chapter 5 Edit Memory Displays the Edit CPU Memory screen. (TD 200C only)p

Force I/O Displays the Force I/O screen. (TD 200C only)

Program Memory
Cartridge

Displays the Make MC screen, allowing you to copy the user
program to the memory cartridge. (TD 200C only)

TD Setup Displays the TD Setup screen.

View Messages Displays the View Messages screen. (TD 200C only)

Password

See Chapter 5

Release
Password

Allows you to immediately restore the password-protection for the
TD 100C and TD 200C.
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Exporting the Keypad Layout to a Graphics Application
After you have configured the buttons on the keypad, you can create the graphical representation
for the faceplate. You can use any third-party graphics application to add colors, lines and other
artwork to the panel design.

The Keypad Designer exports the layout of the
buttons as a bitmap file (*.bmp) that you edit with
the graphics application.

As shown in Figure 3-12, the button template
provides a bitmap image of the layout of the
keypad that you can use with your graphical
application to position, size and align the
graphical elements of your faceplate design.
These elements can include logotype, text, or
other images.

The Keypad Designer allows you to export the
layout of the buttons into your graphics
application. Use the File > Export >Button
Template to File menu command to create a
bitmap file (*.bmp) that you insert into the
graphics application.

After you customize the layout (adding
background image, colors, buttons or logotype),
you save the file as a bitmap (*.bmp). This bitmap
becomes the panel image for the Keypad

Keypad Designer

Design the graphics for the
faceplate:

Design the background for the
panel image

Design the button images

Add text for the buttons

Third-Party
Graphics Application

Export the button template (layout
for the keypad) to a third-party
graphics application

becomes the panel image for the Keypad
Designer. Figure 3-11 Creating the Panel Image: Export

Button Layout

Tip
When designing the colors for your panel image, remember that any white area will be printed
as transparent (clear).

Keypad Layout
(in the Keypad Designer)

Button Template
(exported to a graphics application)

Figure 3-12 Exporting the Button Template to a Graphics Application
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Adding a Panel Image to the Faceplate
Using your own graphics application, you create
the following graphical elements for the faceplate
of the TD 100C or the TD 200C:

Button images

Background image or color scheme

Text (for the buttons or the background)

Logotypes (and other images or text)

You are not required to use square buttons.
However, you must ensure that your button
design covers the area of the button as defined in
the button template.

After you have used your graphics application to
modify the panel image for the faceplate, save
the design as a bitmap file (* bmp)

Keypad Designer

Save the completed panel image
as a bitmap (*.bmp)

Third-Party
Graphics Application

Import the completed panel image
to the Keypad Designer

the design as a bitmap file (*.bmp).
Figure 3-13 Creating the Panel Image: Import

Panel Image

Importing a Panel Image
When you have completed the graphical design
of panel image for the faceplate, you import the
panel image back into the Keypad Designer.

After you open your keypad project (*.td1 or
*.td2), use the File > Import >Panel Image from
File menu command to select the bitmap file that
you created with your graphics application.

Figure 3-14 Keypad with a Panel Image

Tip
When you design your faceplate, you can create the bitmap with any resolution. However, the
size of the background image for the TD device must exactly match the following dimensions:

For the TD 200C:
Width: 137 mm (+/-- 0.15 mm) (5.42 inches)
Height: 65.7 mm (+/-- 0.15 mm) (2.58 inches)

For the TD 100C:
Width: 79 mm ((+/-- 0.1 mm) (3.11 inches)
Height: 65.8 mm (+/-- 0.1 mm) (2.59 inches)

If your faceplate design does not match these dimensions, the Keypad Designer alerts you
before importing the panel image. If you import a panel image with incorrect dimensions, the
Keypad Designer resizes your panel image, which could distort the appearance of your
faceplate design.
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Saving the Keypad to a TD Configuration File
When you save the keypad, you create a TD
configuration file (*.td1 for the TD 100C, and *.td2
for the TD 200C). This file contains the following
information about the buttons on the keypad:

Number of buttons

Location and sizes of the buttons

Names of the buttons

Functions assigned to the buttons

Panel image (if one was imported)

Use the File > Save or File > Save As menu
command to save the configuration of the
keypad.

The Text Display Wizard uses this information for
fi i th TD 100C TD 200C S

Keypad Designer

Save the keypad configuration
file (*.tdx)

STEP 7--Micro/WIN
Text Display Wizard

Select the keypad configuration file
(*.td1 or *.td2) when configuring the
TD device with Text Display Wizard

configuring the TD 100C or TD 200C. See
Chapter 4 for more information.

Figure 3-15 Saving the TD Configuration File

Tip
The Keypad Designer allows you to save invalid or incomplete configurations. This allows you
to save interim versions of your work. However, always ensure that the final configuration of the
keypad is valid and complete before using the configuration file (*.tdx) with the Text Display
wizard.

Reversing the Panel Image
The Reverse Panel Image option only affects the way that the panel image is saved to a file using
the File > Export > Panel Image to File menu command. The exported bitmap file can then be
inserted into the Microsoft Word template. For more information see the next section, Printing the
Panel Image on a Faceplate. The Reverse Panel Image option does not change the layout of the
keypad.

Printing a reversed image allows you to
orient the side of the faceplate with the ink
from the printing process towards the TD
device. The operator then touches only the
plastic membrane and not the ink when
pressing a button. See Figure 3-16.

Printing a non-reversed panel image allows
the elements to be read correctly when
printed Use the non-reversed panel imageprinted. Use the non-reversed panel image
when you print a paper copy of the
faceplate for review See Figure 3 17

Figure 3-16 Reversed Panel Image

faceplate for review. See Figure 3-17.

Use the File > Export > Reverse Panel Image
menu command to select this function. A check
mark notifies you that Reverse Panel Image
function is selected.

Figure 3-17 Non-Reversed Panel Image
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Printing the Panel Image on a Faceplate
To print your custom-designed panel image onto the blank faceplate material, you must use a
laser printer that supports printing transparency material in both the A4 and envelope formats and
also supports color printing.

You can print a single panel image directly from the Keypad Designer on the
envelope-sized blank faceplate (shipped with the TD device). When you print a single
faceplate (File > Print), the panel image is always reversed.

To print multiple panel images, you can use the Microsoft Word template that ensures your
panel image design is properly sized. You can print multiple panel images onto the
perforated A4-size blank faceplate sheets. See Appendix A for order numbers.

Tip
The faceplate material is specially treated on one side to accommodate printing with a laser
printer. The treated surface is up (or toward you) when you are holding the material with the cut
corner in the top right of the sheet.

Ensure that the material is correctly inserted into the laser printer so that the panel image is
printed onto the treated surface of the material. You must print a reversed-panel image version
onto the faceplate material. To reverse the panel image, see the previous section, Reversing the
Panel Image.

Before printing your panel image onto the blank faceplate sheet, first test your design by printing
the panel image onto regular paper. You can then temporarily use the paper faceplate to test the
functionality of the design with your TD device.

Using the blank faceplate sheets also allows you
to create large quantities of high-quality
faceplates by utilizing the professional printing
services of shops that specialize in laser printing.

You can order additional blank faceplates in
perforated A4-size sheets (10 sheets/package).
The faceplate material is especially designed for
printing with laser printers.

The blank faceplate material is available in two
sizes:

Envelope size for printing a single
faceplate: The Keypad Designer prints
registration lines for trimming the faceplate
to the correct dimensions. (Use a metal
straight edge and a knife or razor blade to
ensure accurate and straight cuts.) The
TD device ships with a single blank
faceplate.

A4 size (210 mm x 297 mm) for printing
multiple copies of the faceplate: You can
use the Microsoft Word template to print the
faceplate onto perforated areas of the
material. You do not have to cut the
faceplates from the material. Order these
A4 sheets from your Siemens distributor.
See Appendix A for order numbers.

Keypad Designer

Print a single faceplate from the
Keypad Designer

Word-Processing Application
(Optional)

Print the faceplate onto the blank
faceplate material:

Use the template for Microsoft
Word (optional)

Set up the printer for the correct
paper size

Print the faceplate

Print multiple faceplates (from a
word-processor application):

Export the panel image

Paste or insert the panel image into
your word-processing application

See Appendix A for order numbers.
Figure 3-18 Printing the Faceplate
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Tip
Before attempting to print a custom faceplate, ensure that both the printer and the
word-processing application are set to the correct paper size:

Single-copy sheet: Set both the printer and word-processing application to print on
Envelope.

Multiple-copy A4 sheet: Set both the printer and the word-processing application to print on
A4-size paper.

Your computer and your laser printer may have other settings that cause the printer to scale the
faceplate to an incorrect size. Always first print a test copy on paper before printing your
faceplate onto the blank material.

Printing a Single Faceplate from the Keypad Designer
You can print individual faceplates directly from the
Keypad Designer:

1. Ensure that the laser printer is set to print
envelopes.

2. Insert the envelope-size faceplate material into
the tray.

3. Select the File > Print menu command.

4. Select the laser printer and click OK.

5. Using the cut lines and a paper cutter, cut the
faceplate from the material.

Cut Lines

p
Figure 3-19 Printing a Single Faceplate

Tip
For best results use a razor-blade cutting knife with a metal straight edge to cut the faceplate
from the material. You can also use a high-quality paper cutter. Be especially careful when using
scissors or similar tools. Scissors are more likely to stretch or tear the material, causing irregular
edges for the faceplate.
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Printing the Faceplate from a Word-Processing Application
You use a word-processing application (such as Microsoft Word) to print multiple copies of the
faceplate onto A4-size blank faceplate material. After you export the panel image of the faceplate
into a document, you adjust the location of the panel images and print the document.

Tip
Siemens provides document files (in 6 languages) for Microsoft Word that helps you to align the
panel images for the perforations on the A4 blank faceplate material. To open these documents,
browse to the Templates subdirectory under the Keypad Designer application (C:/Program
Files/Siemens/TD Keypad Designer/Templates) and select the template for your TD device and
language.

Before printing the faceplate onto the blank faceplate
material, you must ensure that the document and the
printer settings are both set to print on A4 paper. Also,
ensure that the laser printer itself is configured to print
A4 paper.

After you print the faceplate document, you use the
perforations to remove the faceplates from the sheet.

To export the panel image to your word-processing
application:

1. Open your word-processing application
(Microsoft Word) and open the template file.

A4 Faceplate
Material

Perforated Areas

(Microsoft Word) and open the template file.

2. Open the Keypad Designer. Figure 3-20 Printing Multiple Faceplates

3. In the Keypad Designer, select the File > Export > Panel Image to File menu command to
create a bitmap file that you insert into the word-processing application.

4. Insert the panel image into the document by using the word-processing application to insert
the bitmap file (*.bmp) that you created with the Keypad Designer.

5. Follow the instructions in the template file for positioning and sizing the faceplate.

6. After inserting the panel image into the document, save the document using the
File > Save As menu command of the word-processing application.

With the panel images saved in your document, you can print the document to your laser printer.

Tip
Before printing the panel image onto the blank faceplate material, first test your design by
printing the faceplate onto regular A4 paper.
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Installing the Printed Faceplate onto the TD device
Use the following procedure to install your faceplate on
the TD device. The example shown here is for the
TD 200C. Installing a faceplate on a TD 100C is similar;
the differences are noted.

1. Remove the blue protective covering over the
display of the TD device.

2. As shown in Figure 3-21, remove the strip of
protective paper on the left side of the TD 200C
to expose a strip of the adhesive. For the
TD 100C, this strip is on the right side of the
device.

3. Carefully align your custom faceplate on the
entire TD 200C, and then seal the faceplate to
the exposed adhesive by pressing down on the
left side of the faceplate. For the TD 100C press
down on the right side of the faceplate.

4. Carefully lift back the unadhered faceplate and
remove the rest of the protective paper from the
TD device.

5. Carefully position the faceplate onto the
TD device. Firmly press the faceplate onto the
adhesive, taking care to remove any air bubbles
that may have been trapped underneath.

Refer to Chapter 2 for additional information about
installing the TD devices, including the dimensions for
the faceplate.

4

2

3

5

Custom Faceplate

Figure 3-21 Adhering the Faceplate onto
the TD Device
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Using the Text Display Wizard to
Configure the S7-200 CPU for Your
TD Device

You do not configure or program the TD device. The Text Display wizard creates a parameter
block that stores the configuration, screens and alarms for the TD device. The S7-200 CPU stores
the parameter block in V memory. At power-up, the TD device reads the parameter block from the
S7-200 CPU.

You use the Text Display wizard of STEP 7--Micro/WIN to perform the following tasks:

Configuring the parameters for the TD device

Creating the screens and alarms to be displayed on the TD device

Creating the language sets for the TD device (TD 200C and TD 200 only)

Assigning the V memory address for the parameter block

Tip
To connect your TD device to a network, you use the Diagnostic or TD Setup Menu of the
TD device to set up the network addresses, baud rate and other parameters. Refer to
Chapter 5.

In This Chapter
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Embedding a Variable into the Text of an Alarm 57. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Configuring the Language Sets for the TD Device
(TD 200C, TD 200 only) 59. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Overview of the Configuration Tasks
The S7-200 CPU stores the configuration data for the TD device, including the screens and
alarms, into a parameter block (located in V memory). The Text Display wizard creates the
parameter block. When you download your project (user program and data block) to the
S7-200 CPU, you also download the parameter block as part of the data block.

You do not configure or program the TD device. At power-up, the TD device reads the parameter
block from the S7-200 CPU.

As shown in Figure 4-1, you use the Text Display wizard of STEP 7--Micro/WIN to create the
parameter block for the TD devices. Figure 4-2 shows the sequence of the tasks required for
configuring the parameters of the TD device.

Keypad Designer
Save the keypad configuration file
(*.td2 for the TD 200C, and *.td1
for the TD 100C)

STEP 7--Micro/WIN
Text Display Wizard

Create the screens and the alarms for
your operator interface

Configure the parameter block for the
TD device (V memory in the
S7-200 CPU)

TD 200 TD 200C

Parameter Block

When you download your user program, the
S7-200 CPU stores the parameter block in
the V memory address you selected

TD 100C

Figure 4-1 Using the Text Display Wizard to Configure the TD Device
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Parameter Block Address

Define the address of the parameter block
(V memory)

Language Sets (TD 200C, TD 200 only)

Define the languages sets:
Select the language for the prompts and
menus

Select the character set

Define the screen
Define the text

Add any variable data

Add any icons
(TD 200C only)

Screens

Create the user menu
Define the menu items

Add the screens

Define the alarm message
Define the text

Add any variable data

Add any icons (TD 200C only)

Alarms

Select the display options:
Define the length for the
message

Determine/define the default
display mode

Enable the CPU functions

Select the update rate

Select the language and character set

Configure the buttons

TD Parameters

Select the type of TD device

Translate the alarms
and the screens

Figure 4-2 Configuration Tasks of the Text Display Wizard
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Configuring the TD Device
STEP 7-Micro/WIN provides a wizard that makes it easy to configure the parameter block and the
messages in the data memory area of the S7-200 CPU.

Task Overview
As shown in Figure 4-3, the Text Display wizard performs the same basic tasks for configuring the
TD devices. However, the specific selections reflect the differences between the TD devices.

Select functions to be
enabled:

Password protection
Set Time and date
Force I/O

Select the update rate
for the TD 200

Select language and
character set for prompts
and menus of the TD 200

Configure the action for
the buttons on the keypad

Select functions to be
enabled:

Password protection
Set Time and date
Force I/O
Change CPU to STOP or
RUN mode
Copy the user program to
a memory cartridge
Edit the CPU memory

Select the update rate for
the TD 200C

Select the language and
character set for the
prompts and menus

Configure the buttons on
the keypad:

Load the configuration file
(*.td2) for the custom
keypad
Configure the action for the
buttons on keypad

Select the TD device

TD 100CTD 200

Select functions to be
enabled:

Password protection
Set Time and date

Select the update
rate for the TD 100C

Configure the buttons
on the keypad:

Load the configuration
file (*.td1) for the
custom keypad
Configure the action
for the buttons on
keypad

TD 200C

Select the language
and character set for
the prompts and
menus

Figure 4-3 Tasks Required for Configuring the Parameters of the TD Device
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Starting the Text Display Wizard for the TD Device
You use the Text Display wizard to configure the parameters for the TD device. You can also use
the Text Display wizard to modify an existing TD configuration.

To open the Text Display wizard:

1. Start STEP 7--Micro/WIN.

2. Select the Tools > Text Display
Wizard menu command.

The Text Display wizard displays the
Introduction dialog, as shown in
Figure 4-4.

If the Text Display wizard finds an
existing TD configuration, the
Introduction dialog provides a list of
existing TD configurations and allows
you to select a TD configuration to
modify.

Use the Next button to proceedUse the Next button to proceed
through the dialogs of the wizard. Figure 4-4 Text Display Wizard

Selecting the Type of TD Device to Configure
As shown in Figure 4-5, the Text
Display wizard prompts you to select
the type of TD device to be
configured.

The Text Display wizard uses this
selection to display the dialogs for
configuring the parameters for your
specific TD device.

Figure 4-5 Selecting the TD Device
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Selecting a Password for the TD Device
Selecting a password for the TD device helps you to protect the security of your process or
application. By enabling a four-digit password (from 0000 to 9999), you can control access to the
S7-200 CPU by requiring that an operator enter the password before editing variables from the
TD device.

The TD password also restricts access to the following TD functions:

Set time and date

TD Setup

Forcing I/O

Changing the CPU mode

Creating a memory cartridge

Editing CPU memory

Tip
The TD password affects only the ability of an operator to use the TD device for certain
functions.

If your S7-200 CPU is configured to require a password, the operator must enter the CPU
password to force I/O and create a memory cartridge. The TD password is used in addition to
the CPU password.

Enabling the TD Menu Functions
You can select the TD functions that appear on your TD device menu. The TD devices have
different functions available. Refer to Chapter 5 for information about these CPU functions.

TD 200
Select the functions you want to
appear on the TD 200 menus. The
TD 200 supports the following
functions:

Setting the Time-of-Day clock:
Allows you to set the time and
date for the S7-200 CPU

Forcing I/O: Allows you to force
I/O points in the S7-200 CPU to
be on or off

Figure 4-6 Enabling the CPU Functions for the TD 200
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TD 200C
Select the functions you want to appear on the TD 200C menus. The TD 200C supports the
following functions:

Setting the Time-of-Day clock: Allows you to set the time and date for the S7-200 CPU

Forcing I/O: Allows you to force I/O points in the S7-200 CPU to be on or off

Creating a memory cartridge:
Allows you to create a memory
cartridge which is a complete
copy of the CPU

Changing the operating mode:
Allows you to set the S7-200
CPU to STOP or RUN

Editing the CPU memory: Allows
you to view and change the
values of the data stored in the
S7-200 CPU

Figure 4-7 Enabling the CPU Functions for the TD 200C

TD 100C

Select the function you want to appear
on the TD 100C menus.

The TD 100C supports the Setting the
Time-of-Day clock function. This
function allows you to set the time and
date for the S7-200 CPU function.

Figure 4-8 Enabling the CPU Functions for the TD 100C
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Selecting the Update Rate for the TD Device
You can select how often the TD device performs a read operation to update the information from
the S7-200 CPU. You can select from “As fast as possible” to “Every 15 seconds” (in one-second
increments).

Selecting the Language and the Character Set
The Text Display wizard allows you to select the language for the system menus and prompts of
the TD device. This selection does not affect the language setting for the screens or alarms that
you enter. You select a character set that supports the language of the text that you enter for the
screens and alarms. (If the character set does not match the Windows character set, the Text
Display wizard may not display the characters correctly. The TD device displays these characters
correctly.)

Select the language for the
system menus and prompts
displayed by the TD device.

The TD device supports English,
French, German, Italian,
Simplified Chinese, and
Spanish.

Select the character set for the
text in your alarms and screens.

Refer to Appendix A for
descriptions of the character
sets supported by the
TD device. The Simplified
Chinese Character Set is an
electronic file that resides on the
STEP 7 Mi /WINSTEP 7--Micro/WIN
documentation CD.

Figure 4-9 Localizing the TD Device

These settings define a language set for the TD device. The Text Display wizard also provides a
series of dialogs for copying the alarms and screens to create additional language sets (TD 200C
and TD 200 only). For each language set, you select the language and the character set.

Tip
When you create multiple language sets (TD 200C and TD 200 only), the Text Display wizard
copies the alarms and screens from the primary language set to the other language set. You
then edit the screens and alarms to translate the text displayed for the new language set.

If you need to modify the screens or messages (such as to add a new variable or to add a new
alarm), you must edit the primary language. The Text Display wizard copies these changes to
the other language sets.

The Text Display wizard only allows you to change the text in the other language sets.
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Selecting the Font Size (TD 100C only)
For all character sets except Simplified
Chinese, the TD 100C supports two
font sizes for displaying user
messages. Larger fonts are easier to
read, but will result in fewer characters
per user message. The following font
sizes are available:

Small font (16 characters per
line)

Large font (12 characters per
line)

The Simplified Chinese character set
displays 8 Chinese characters per
line.

Figure 4-10 Selecting the Font Size (TD 100C)

Loading a Custom Keypad (TD 100C and TD 200C Only)
The TD 100C and TD 200C allow you to create a custom keypad. As described in Chapter 3, you
can insert buttons onto the keypad. The Keypad Designer saves this configuration to a file (*.td1
for the TD 100C and *.td2 for the TD 200C).

To load the keypad configuration file
into the Text Display wizard:

1. Select the option, Use a custom
keypad created with the Keypad
Designer. (Find this check box in
the Options area of the
Configure Keypad Buttons
dialog. See Figure 4-11.)

2. Browse to the keypad
configuration file (*.tdx) that you
created with the Keypad
Designer.

The Text Display wizard loads the
keypad configuration file and updates
the table of buttons and the buttonthe table of buttons and the button
symbols. Figure 4-11 Configuring the Functions for the Buttons

The Text Display wizard lists only those buttons that you had defined with the Set Bit functionality
when you created the buttons with the Keypad Designer.
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Configuring the Buttons on the Keypad
As shown in Figure 4-11, the Configure Keypad Buttons dialog allows you to select a symbol
name and an action for each of the configurable buttons on the TD device.

The TD 200 keypad provides 4 configurable buttons and a SHIFT button that can be
configured for up to 8 bits in the S7-200 CPU

The TD 200C can be configured for up to 20 configurable buttons

The TD 100C can be configured for up to 14 configurable buttons

Tip
The Configure Keypad Buttons dialog of the Text Display wizard displays only those buttons that
set bits in the S7-200 CPU. The Text Display wizard does not list the buttons with other
functionality, such as ESC or SHIFT.

The symbols that you assign to the buttons on the keypad allow the logic of your user program in
the S7-200 CPU to interact with the TD device. (The Text Display wizard suggests a symbol for
these buttons. You can accept the recommendation or enter a new symbol for the button.)

For each button, you configure the type of action:

Set bit: When you press the button on the TD device, the TD device sets the bit on in the
S7-200 CPU. The bit stays on until the logic of your user program in the S7-200 CPU resets
the bit.

Momentary contact: When you press the button on the TD device, the TD device sets the
bit on in the S7-200 CPU. When the TD device button is released, the TD device turns the
bit off in the S7-200 CPU.

Tip
The TD device only sets the bit on or off in the S7-200 CPU a single time when the TD device
button is either pressed or released.

Tip
The TD devices can display a special icon on the display to provide visual feedback to the
operator that the key was pressed on the bit set in the CPU. Check the box at the bottom of the
Configure Keypad Buttons wizard screen to enable this feature (see Figure 4-11).
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Configuring the Screens for the TD Device
The TD device supports a set of user-defined screens and a user menu. Screens allow the
operator using the TD device to initiate the interaction with the S7-200 CPU.

User menu: Provides a hierarchy for switching between groups of screens. For the
TD 200C and the TD 200 you configure up to 8 entries in the user menu. For the TD 100C,
you configure up to 4 entries in the user menu.

Screens: You create up to 8 screens for each entry in the user menu.

The TD device displays the screens and the items
on the user menu in the order that you configure
them.

If you configure both alarms and screens, you also
designate the default display mode for the
TD device.

The operator uses the buttons on the keypad to
navigate through the user menu or the screens that
you configured.

Figure 4-13 shows the buttons that a TD operator
could use to navigate from a user menu to the
screens associated with that item in the menu.

Define the screen
Define the text

Add variable data

Add icons

Screens

Create the user menu
Define the menu items

Add the screens

Figure 4-12 Configuring the Screens

You can configure up to 8 items
(TD 200C and TD 200), or up to 4
items (TD 100C) for the user menu

User menu item 1

User menu item 4

User menu item 5
User menu item 6

ENTER displays
the screens

The UP Arrow scrolls up through
the list and wraps to the last item

Enter

ESC
ESC returns to
the user menu

User menu item 2

The DOWN Arrow scrolls down
through the list and wraps to the
first screen

The DOWN Arrow scrolls down through
the list and wraps to the first item

User menu item 7
User menu item 8

The UP Arrow scrolls up through
the list and wraps to the last
screen

User menu item 3 Screen 1: 2 or 4 lines
Can be interactive

You can configure up to 8 screens
for each user menu item

Screen 2: 2 or 4 lines
Can be interactive

Screen 3: 2 or 4 lines
Can be interactive

Screen 4: 2 or 4 lines
Can be interactive

Figure 4-13 Navigating through a Hierarchy of User-Defined Screens

Tip
The screens in the TD 200 and TD 200C are always two lines, and the screens in the TD 100C
are always 4 lines.
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After you have configured the TD device, you can configure the screens and the user menu. Click
the user menu icon to start creating the user menu for the screens. See Figure 4-14.

For the user menu, you perform the following tasks:

Create the groups (names) to be
displayed on the user menu

Determine the sequence of the
groups listed on the user menu

For the screens, you perform the
following tasks:

Add the screens to each group
(on the user menu)

Create the text message (and
add variables) for each screen

Add icons to the text message
(TD 200C only)

Determine the sequence of the
screens for each groupg p

Figure 4-14 Selecting the Screen Configuration Tasks

Creating the User Menu
The process for creating the screens and user menu is not sequential: You can choose to enter
the screens for each individual group before creating the next group, or you can enter all of the
groups for the user menu before creating any of the screens.

To configure the user menu, you enter the names for each group of screens. See Figure 4-15 for
an example of the TD 200C. The Text Display wizard displays a green ENTER icon (and blue
arrow) to show which group is selected.

To create the screens associated with
a group on the user menu:

1. Move the cursor to the box that
designates the group on the
user menu.

2. Click the Add Screen button.

3. Create the text for the screen.

4. Click the Add Screen button to
create the other screens in this
group.

Use the Move Choice Up and Move
Choice Down buttons to change the
sequence of the groups listed on the
user menu.

Figure 4-15 Defining the User Menu
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Creating the Text for a Screen
Your screen message can contain the
following elements:

Text: Enter your text in the green
area that represents the text
display area of the TD device

Icons (optional): Click the icons
in the toolbar to insert the icon
into the text message (TD 200C
only)

Variable data (optional): Click
the Insert PLC Data button to
embed a variable into the text
message

You can designate the screen to be
the default screen. The TD will show
the default screen after being powered
on.

Figure 4-16 Creating the Message for a Screen

Embedding a Variable into the Text of a Screen
You can embed a variable data field into the text of the screen. To open the Insert PLC Data
dialog, move the cursor to the location for the variable in your text and click the Insert PLC Data
button. As shown in Figure 4-17, you enter the following information:

Tip
For the TD 200C and the TD 200, you can embed up to 6 variables per screen. For the
TD 100C, you can embed up to 1 variable per line (4 variables per screen).

Data address:

VB: Numeric String, Text String

VW: Signed, Unsigned

VD: Real, Signed, Unsigned

Data Format: Signed, Unsigned,
Real, Numeric String, or Text
String

Digits to the right of the decimal:
Up to 7

Figure 4-17 Inserting PLC Data

The TD device rounds a real number to the specified decimal place. For example, if the real
number value is 123.456 and you select 2 digits to the right of the decimal, the TD 200 displays
this value as: 123.46.

Tip
Refer to the SIMATIC S7-200 Programmable Controller System Manual for information about
the data types or for the memory addresses supported by the S7-200 CPU.
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You can also allow the operator to modify the data stored at this memory location in the
S7-200 CPU.

You can require the operator enter the TD password before editing the variable. (You must
have enabled password-protection for the TD device.)

You can configure the cursor to jump to the variable field.

You can define a symbolic name for the variable. You use the symbolic name to access this
data with your user program.

Clicking OK inserts the variable into the text of the screen. The Text Display wizard inserts a block
of 4 characters to show the presence of the variable. The value to be displayed for the variable is
right-justified at that location (anchored to the right-most character).

Data values are always right-justified to the right-most character of an embedded variable. As a
data value grows in magnitude, it utilizes more spaces to the left of the anchor point and can
overwrite the text characters. Always provide sufficient space between the end of your text and
the anchor point to allow for the expected range of the data value.

Tip
The actual number of characters used to display a value varies with the size of the value. To
help calculate the number of characters required for displaying the value of the variable, see the
examples listed in Table 4-1.

The TD device displays all values as decimal numbers. Positive signed values are displayed
without a sign, and negative signed values are displayed with a leading minus sign. Unsigned
values are displayed without a sign. A leading zero is used for all fractional numbers (for example,
0.5). Real numbers are displayed with the number of decimal places you specify. The value is
rounded to the specified decimal place.

Table 4-1 Calculating the Number of Characters Required to Display a Value

Size Type
Resolution
(Digits to right
of decimal)

Maximum Number of
Characters

Example

Byte
(VB)

String Not applicable Line length1 Hello, world
(VB)

Numeric
String

Not applicable Line length1 800.333.7421

Word

(VW)

Unsigned 0

1 to 4

5

6

7

5

6

7

8

9

12345

1234.5, 1.2345

0.12345

0.012345

0.0012345

Signed 0

1 to 4

5

6

7

6

7

8

9

10

--12345

--1234.5, --1.2345

--0.12345

--0.012345

--0.0012345

Double-Word

(VD)

Unsigned 0

1 to 7

10

11

1234567890

123456789.1, 123.4567891

Signed 0

1 to 7

11

12

--1234567890

--123456789.1, --123.4567891

Real 0

1 to 7

Line length1

Line length1
--1234567

12345.6, 0.0123456
1 The length of a line (number of characters in a line) varies by TD model and character size. The line length is always 20 for
a TD 200 or TD 200C. The line length is either 12 or 16 characters for a TD 100C.
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Embedded String Variables
There are special considerations when you set up a string variable for the TD devices. String
variables are positioned the same as numeric variables, that is, the right-most character of the
variable is positioned at the right-most position of the embedded variable in the Text Display
wizard. This can cause problems when you want to place a text string adjacent to other text in the
message.

When you embed a string variable in a TD alarm or screen, the Text Display wizard shows the
embedded variable occupying 4 character spaces (or 2 Chinese characters) for the variable.
These 4 spaces are the right-most 4 characters of the text string. If you want to have the text
adjacent to other text, that is, to the left of the variable, the characters in the string need to be
left-justified and padded with spaces to place the text in the proper position on the display.

For example: Assume that we want to show the pump status and that status is either “Pump OK”
or “Pump High Temp”. The screen display shows the word “Pump” followed by a string variable
which is set to either “OK” or “High Temp”. You set up the display in the Text Display wizard like
this:

Pump_ _ _ _ _ _ ����

The underlines are blank spaces and the ���� is
the embedded variable (which takes up 4 character
spaces). You can create 2 strings that you copy
into the variable based on the current pump status.
These strings are “OK” and “High Temp”. These

Pump High Temp Pump OKor

ese st gs a e O a d g e p ese
strings are displayed as shown in Figure 4-18. Figure 4-18 Embedded String Variable

The right-most character of the “OK” string is
placed in the right-most position of the embedded
variable. Since the string is only 2 characters, it
displays on the right side of the display where the
embedded variable is placed.

To make the “OK” string display next to “Pump”,
i l dd bl k t th “OK” t i t

Pump OK

g p y p ,
simply add blank spaces to the “OK” string to
match the length of the other string. The “OK”
string would become “OK ”. Now the string is
displayed as shown in Figure 4-19.

Figure 4-19 Embedded String Variable with
Blank Spaces

Figure 4-20 shows how to create the two strings
using the STR_CPY command. Note how the “OK”
string is padded with blank spaces to left justify the
characters on the TD display.

Figure 4-20 Using STR_CPY to Create Strings



SIMATIC Text Display (TD) User Manual

54

Configuring the Alarms
Alarms allow the user program in the S7-200 CPU to initiate interaction with the operator by
displaying an alarm message on the TD device. When your user program sets an alarm bit, the
TD device reads the text of the alarm from the S7-200 CPU.

Figure 4-21 lists the key tasks for creating alarms.
You configure the following information for each
alarm:

Number of alarms: Up to 80 alarms for the
TD 200 and TD 200C, and up to 40 alarms
for the TD 100C to be configured for the
TD device

Text message for the individual alarms

Priority for the alarms is determined by the
sequence in which you configure the alarms:

-- The first alarm has the highest priority

-- The last alarm has the lowest priority

Acknowledgement (if required)

The TD 200 and TD 200C devices store up to 80

Define the alarm message
Define the text

Insert a variable (optional)

Insert an icon (optional)
(TD 200C only)

Alarms

Select the display options:
Define the size of the alarms
(either 1 or 2 lines)

Define how to announce the
alarm

The TD 200 and TD 200C devices store up to 80
alarms, and the TD 100C device stores up to 40
alarms. The TD displays the alarm messages
according to priority.

Figure 4-21 Configuring the Alarms

As shown in Figure 4-22, the operator uses the buttons on the keypad to scroll through the list of
alarms.

Alarm (highest priority)

Alarm

Alarm
Alarm

Acknowledges the alarm
that you have selected

Scrolls up through the list of alarm
messages and wraps to the last item

Enter

ESC Returns to the
main menu

Alarm

Scrolls down through the list of alarm
messages and wraps to the first item

Alarm

Alarm
Alarm (lowest priority)

You can configure up to 80 alarms for your TD 200 or TD 200C, and up to
40 alarms for your TD 100C:

The order of the alarms in your configuration determines the priority:

The first alarm in your configuration has the highest priority

The second alarm in your configuration has the second-highest priority

The last alarm in your configuration has the lowest priority

Figure 4-22 Alarm Messages
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Determining the Type of Operator Interaction for an Alarm
The Text Display wizard allows you to determine the type interaction required by the operator for
an alarm. If the user screens are set as the default display mode for the TD device and an alarm is
enabled, an alarm indicator will begin to flash on the TD display. The indicator is large if there is an
alarm enabled that requires acknowledgement. The indicator will be small if the alarms do not
require acknowledgement. The user can switch to the alarm display to view the alarms.

The alarm display will show one or more alarms in priority order. An UP or DOWN arrow in the
right-most character position indicates more alarms are active, but not visible on the display. The
operator can press either the UP or the DOWN arrow key to scroll through the other enabled
alarms.

The operator can edit or accept variable values by pressing the ENTER key. The TD device will
write the updated variable value to the CPU and set the edit notification bit for that variable when
the operator presses the ENTER key. The TD device then moves the cursor to the next editable
variable. Pressing ENTER for the last editable variable of an alarm writes this last value to the
S7-200 CPU and the TD device then resets the alarm enable bit. For more information on editing
variables, see Editing a Variable that is Embedded in an Alarm or a Screen in Chapter 5.

Every alarm falls into one of four possible alarm acknowledgement and editing types. This section
explains specifically how each alarm type is handled by the TD device. The four alarm types
follow:

No acknowledgement required, no edits allowed

Acknowledgement required, no edits allowed

No acknowledgement required, edits allowed

Acknowledgement required, edits allowed

No Acknowledgement Required, No Edits Allowed
In this combination of no acknowledgement required and no edits allowed, the TD device simply
displays the alarm. The ENTER key has no function since there are no editable variables within
the alarm. The alarm may contain variables that are updated at the update rate of the TD device.
This type of alarm is replaced on the display if a higher priority alarm is enabled by the S7-200
CPU. The operator can either press the UP or the DOWN arrow key to scroll to other alarms or
press ESC to return to the menus.

The TD device does not clear the corresponding alarm-enable bit in the S7-200 CPU.

Acknowledgement Required, No Edits Allowed
In this combination of acknowledgement required and no edits allowed, the TD device displays
the alarm and makes the entire alarm flash (blink) until the operator presses ENTER to
acknowledge the alarm. Variable values are updated from the S7-200 CPU at the normal update
rate while the alarm is flashing.

When the operator presses ENTER, the TD device:

Sets the acknowledgement-notification bit for this alarm.

Clears the alarm-enable bit for this alarm. This causes the alarm to be removed from the
display on the next update cycle.

Another alarm cannot replace the one flashing until the operator acknowledges the flashing alarm.
This is also true even if a higher priority alarm is enabled in the S7-200 CPU. If the TD device is
configured for single line alarms and the CPU enables a higher priority alarm, the flashing alarm
shifts down to the next line of the display. The operator cannot press the UP or the DOWN key to
scroll through other enabled alarms until the current alarm is acknowledged.
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No Acknowledgement Required, Edits Allowed
In this combination of no acknowledgement required and edits allowed, the TD device displays a
alarm and then waits for the operator to edit a value in the alarm. All of the variables within the
alarm are updated at the update rate. Since the alarm does not require acknowledgement, this
type of alarm is removed from the TD device display if a higher priority alarm is enabled in the
S7-200 CPU.

Acknowledgement Required, Edits Allowed
In this combination of acknowledgement required and edits allowed, the TD device displays the
alarm, causes the entire alarm to flash (blink), and then waits until the operator acknowledges the
alarm and edits or accepts the values in the alarm. This type of alarm requires that the operator
edits or accepts the values displayed in the alarm. If the operator aborts the edit by pressing the
ESC key before editing all the values in the alarm, the alarm flashes to indicate that edits are still
required.

When the alarm is enabled in the S7-200 CPU, the TD device notes this and, if there is space
available on the display, reads the alarm from the CPU. The TD device then displays the alarm
and causes the entire alarm to flash to notify the operator that the alarm is present and must be
acknowledged.

Setting the Default Display Mode and Alarm Parameters
The TD device supports alarms that are displayed under program control. After you have
configured the TD device, you can configure the alarms. When you configure the alarms, you also
select either screens (default) or alarms as the default display mode for the TD device.

Click the Alarms icon to start creating
alarms. As shown in Figure 4-23, you
select the following information:

Default display mode: Select
either alarms or screens as the
default display mode. This
selects which type of messages
the TD device displays after
powering up or after a prolonged
period of no key presses by the
user.

Size of the alarms: Select
either 1 line or 2 lines.

For Chinese characters, select
either one row or two rows of
texttext.

Figure 4-23 Configuring the Alarm Options

Tip
The TD 200C and the TD 200 support up to 80 alarms, and the TD 100C supports up to 40
alarms. The priority for the alarms is determined sequentially, from the first alarm (highest
priority) to the last (lowest priority).
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Entering the Text for an Alarm
Clicking Next displays the Alarms dialog shown in Figure 4-24. You can select a symbolic name
for the alarm. The user program uses the symbolic name to enable (and display) the alarm. Click
the New Alarm button to create the alarm message. Your alarm message can contain the
following elements:

Text: Enter your text in the green
area that represents the text
display area of the TD device

Icons (optional, TD 200C only):
Click the icons in the toolbar to
insert the icon into the text
message

Variable data (optional): Click
the Insert PLC Data button to
embed a variable into the text
message

To ensure that important alarms are
acknowledged by an operator, you
can configure the alarm to require
acknowledgement.

You select the symbolic name for the
acknowledgement bit for the alarm.
The user program uses this symbolic
name to report that the alarm has
been acknowledged.

To acknowledge an alarm with theTo acknowledge an alarm with the
TD device, the operator selects the
alarm and presses ENTER.

Figure 4-24 Creating the Text for an Alarm

Embedding a Variable into the Text of an Alarm
You can embed a variable data field into the text of the alarm. To embed a variable, move the
cursor to the location for the variable in your text and click the Insert PLC Data button. As shown
in Figure 4-25, you enter the following information:

Tip
For the TD 200C and the TD 200, you can embed up to 6 variables per alarm. For the TD 100C,
you can embed up to 1 variable per line (1 for one-line alarms, and 2 for two-line alarms).

Data address:

VB: Numeric String, Text String

VW: Signed, Unsigned

VD: Real, Signed, Unsigned

Data Format: Signed, Unsigned,
Real, Numeric String, or Text
String

Digits to the right of the decimal:
Up to 7

The TD device rounds a real
number to the specified decimal
place. For example, if the real
number value is 123.456 andnumber value is 123.456 and
you select 2 digits to the right of
the decimal, the TD 200
displays this value as: 123.46.

Figure 4-25 Inserting a Variable into the Text of an Alarm
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Tip
Refer to the SIMATIC S7-200 Programmable Controller System Manual for information about
data types or for the memory addresses supported by the S7-200 CPU.

You can also allow the operator to modify the data stored at this memory location in the
S7-200 CPU.

You can require the operator enter the TD password before editing the variable. (You must
have enabled password-protection for the TD device.)

You can configure the cursor to jump to the variable field.

You can define a symbolic name for the variable. You use the symbolic name to access this
data with your user program.

Clicking OK inserts the variable into the text of the alarm. The Text Display wizard inserts a block
of 4 characters to show the presence of the variable. The value to be displayed for the variable is
right-justified at that location (anchored to the right-most character).

Data values are always right-justified to the right-most character of an embedded variable. As a
data value grows in magnitude, it utilizes more spaces to the left of the anchor point and can
overwrite the text characters. Always provide sufficient space between the end of your text and
the anchor point to allow for the expected range of the data value.

Tip
The actual number of characters used to display a value varies with the size of the value. To
help calculate the number of characters required for displaying the value of the variable, see the
examples listed in Table 4-2.

The TD device displays all values as decimal numbers. Positive signed values are displayed
without a sign, and negative signed values are displayed with a leading minus sign. Unsigned
values are displayed without a sign. A leading zero is used for all fractional numbers (for example,
0.5). Real numbers are displayed with the number of decimal places you specify. The value is
rounded to the specified decimal place.

For more information about embedding string variables in an alarm, see page 53.
Table 4-2 Calculating the Number of Characters Required to Display a Value

Size Type
Resolution
(Digits to right
of decimal)

Maximum Number of
Characters

Example

Byte
(VB)

String Not applicable Line length1 Hello, world
(VB)

Numeric
String

Not applicable Line length1 800.333.7421

Word

(VW)

Unsigned 0

1 to 4

5

6

7

5

6

7

8

9

12345

1234.5, 1.2345

0.12345

0.012345

0.0012345

Signed 0

1 to 4

5

6

7

6

7

8

9

10

--12345

--1234.5, --1.2345

--0.12345

--0.012345

--0.0012345

Double-Word

(VD)

Unsigned 0

1 to 7

10

11

1234567890

123456789.1, 123.4567891

Signed 0

1 to 7

11

12

--1234567890

--123456789.1, --123.4567891

Real 0

1 to 7

Line length1

Line length1
--1234567

12345.6, 0.0123456
1 The length of a line (number of characters in a line) varies by TD model and character size. The line length is always 20 for
a TD 200 or TD 200C. The line length is either 12 or 16 characters for a TD 100C.
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Configuring the Language Sets for the TD Device
(TD 200C, TD 200 only)

The Text Display wizard allows you to configure multiple language sets for your TD 200C and
TD 200, including not only the system prompts or messages, but also for the user alarms, user
menus, and screens. The Text Display wizard copies the user alarms and user screens that you
have configured into the language set. You must manually enter the translated text for each alarm,
menu, or screen.

For each language set, you select the following information:

Language for the system
prompts

Character set

Identifier

You also select which of the language
sets is the primary language for the
TD device.

Language Sets

Define the languages sets:
Select the language for the system menus and
prompts

Select the character set

Figure 4-26 Configuring the Languages for the TD Device

Tip
When you create multiple language sets, the Text Display wizard copies the user alarms,
menus, and screens from the primary language set to the other language set. You then edit the
alarms, menus, and screens to translate the text displayed for the new language set.

If you need to modify the screens or messages (such as to add a new variable or to add a new
alarm), you must edit the primary language. The Text Display wizard copies these changes to
the other language sets.

The Text Display wizard only allows you to change the text in the other language sets.

After you have configured the alarms and screens for one language set, you can add a new
language set:

1. Click the icon to start configuring
the language sets for the
TD device.

2. Add a new language by
selecting New Language Set.

3. Select an existing language set
to be the source for the new
language set.

4. (Optional) Select the option for
primary language to configure
the new language as the default
language set for the TD device.

5. Click the Next button to display
the Localize Display dialog.

Figure 4-27 Adding a Language
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The Localize dialog configures the menus and character set for the TD device:

1. Select the language for the
system menus and prompts of
the TD device.

2. Select the character set for the
text.

3. Enter the name to be displayed
on the TD device for this
language set.

After you click the Next button, the
Text Display wizard copies all of the
user alarms, menus, and screens from
the selected language set to the new
language set.

Figure 4-28 Localizing the Display

Notes for Using the Simplified Chinese Character Set

Tip
The Simplified Chinese character set requires a Chinese version of Windows or a Chinese
emulator to properly display Chinese characters in the Text Display wizard. You must start the
Chinese emulator before you start the STEP 7--Micro/WIN software.

On the TD 200C and the TD 200, you can display up to 20 single-byte characters per line of your
message. Because Simplified Chinese uses double-byte characters, you can display up to 10
double-byte characters per line for a message in Chinese.

On the TD 100C, you can display up to 16 single-byte characters per line of your message.
Because Simplified Chinese uses double-byte characters, you can display up to 8 double-byte
characters per line for a message in Chinese.

The standard ASCII characters, such as numbers, punctuation, and upper and lowercase
alphabet characters, are available when using the Simplified Chinese character set. Depending
on your keyboard and/ or emulator, some of these standard characters may be formatted as
single-byte characters instead of the double-byte characters like the Simplified Chinese
characters. Standard ASCII characters and Chinese characters can be mixed on the TD display.

The Text Display wizard displays 8 or 10 double-byte character places for the text of a screen or
alarm. You can fit any of the following combinations into a character position:

1 double-byte character

2 single-byte characters (standard ASCII)

1 single-byte character and 1 single-byte blank

You cannot fit one single-byte character plus one double-byte character in a character position.

The TD 100C does not support the entire Simplified Chinese character set. The most commonly
used characters have been included in the TD 100C. Characters that are not supported by the
TD 100C are displayed as a square (�).

See the Simplified Chinese Characters Set on the STEP 7--Micro/WIN documentation CD for a list
of supported characters.
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Assigning the V Memory Address for the Parameter Block
The Text Display wizard creates the parameter block that you download to the S7-200 CPU with
your user program. The parameter block includes the configuration data for the TD device and
any screens and alarms that you created.

The Text Display wizard calculates the
amount of memory required for the
parameter block and suggests a
starting address in V memory.

The default location for the parameter
block is VB0.

Parameter Block Address

Define the address of the parameter block
(V memory)

Figure 4-29 Assigning the Address of the Parameter Block

Finishing the Configuration for the TD Device
After you complete the configuration for your TD device, the Text Display wizard displays a
summary dialog. (See Figure 4-30.)

If you enter a name for the TD
configuration, STEP 7--Micro/WIN
creates an entry in the project tree for
the TD configuration.

STEP 7--Micro/WIN also creates the
following subroutines:

TD_CTRL_x (where x is the
TD configuration number)

This subroutine ensures that all
updates for the TD device (such
as alarms or changing the
language setting) occur
immediately.

Your user program should use
SM0.0 to call this subroutineSM0.0 to call this subroutine
every scan. Figure 4-30 Summary Dialog

TD_ALM_x (where x is the TD configuration number)

Your user program uses this subroutine to call the alarm by the symbolic name (configured
by the Text Display wizard). This subroutine requires the S7-200 Symbol Table.
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Operating Your TD Device

Included in this chapter is information about routine operator tasks, such as entering and releasing
the password, editing variables embedded in a message or screen, and checking the status
information of the S7-200 CPU. This chapter also describes the less-routine diagnostic functions
provided by the TD device for troubleshooting problems in the S7-200 CPU, such as forcing I/O or
changing the operating mode.

In This Chapter
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Displaying Information on the TD Device 66. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Using the TD Device to Access Screens and Alarms
The TD devices allow you to structure information as either screens or bit-enabled alarm
messages. You use the buttons of the keypad of the TD device to navigate through the screens
and menus:

TD 200: Uses the standard TD keypad.

TD 100C and TD 200C: Allows you to change the configuration and use your own
custom-designed keypad. (If there is no custom configuration, the TD 100C and TD 200C
defaults to the standard TD keypad configuration.)

Tip
For more information about configuring the functionality of the buttons on the keypad:

Chapter 4 provides information about configuring the buttons for the TD devices. The TD
configuration is downloaded to the S7-200 CPU with your user program.

Chapter 3 provides information about creating a custom keypad layout for the TD 100C and
the TD 200C, and assigning specific functionality for each button. (You then integrate the
custom keypad with the screens and alarm messages as described in Chapter 4.)

As shown in Figure 5-1 and Figure 5-2, the standard TD keypad provides the following buttons:

ENTER and Escape (ESC) buttons:

-- ENTER selects a menu item or
confirms a value.

-- ESC exits from a menu or cancels a
selection.

Configurable buttons:

-- Function keys perform the task that
you configured with the Text Display
wizard. The TD 200 and TD 200C
uses F1 to F4, and the TD 100C uses
F1 and F2.

-- SHIFT on the TD 200 and TD 200C
allows the function keys (F5 to F8) to
perform the task that you configured
with the Text Display wizard.

F1
F5

F2
F6

F3
F7

F4
F8

SHIFT ESC ENTER

Text display area Arrow buttons

Configurable buttons
(and SHIFT)

ENTER
and ESC

F1
F5

F2
F6

F3
F7

F4
F8

SHIFT ESC ENTER

Text display area Arrow buttons

Configurable buttons
(and SHIFT)

ENTER
and ESC

Standard Faceplate (TD 200C)

Standard Faceplate (TD 200)

Figure 5-1 Standard TD 200 and TD 200C
Keyboard



Operating Your TD Device Chapter 5

65

Arrow buttons:

-- UP arrow scrolls (upwards) through
menu items or increments a value that
can be edited.

-- DOWN arrow scrolls (downwards)
through menu items or decrements a
value that can be edited.

-- LEFT and RIGHT arrows move the
cursor left or right within the message
(TD 100C and TD 200C only). For a
TD 200, use SHIFT+DOWN to move
right and SHIFT+UP to move left. You
can also use ENTER to move to the
next variable message.

To select a menu item, use the UP and DOWN

F1 F2 ESC ENTER

Text display area Arrow buttons

Configurable buttons
ENTER
and ESC

Standard Faceplate (TD 100C)

To select a menu item, use the UP and DOWN
arrows to scroll through the list of available items.
The TD device highlights the menu item.

Figure 5-2 Standard TD 100C Keyboard

Pressing ENTER selects the highlighted item.

Pressing ESC returns to the previous menu or screen.
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Displaying Information on the TD Device
The TD device provides both screens (user-defined menus with associated screens of
information) and bit-enabled alarm messages:

Menu: A menu is a list of items that select a grouping of related screens. The TD 200C and
the TD 200 have 8 menus available; the TD 100C has 4 menus available.

Screen or alarm:

-- A screen or alarm for the TD 200 and TD 200C displays up to two lines of text that
provide information for the operator. (Each line can be up to 20 characters of text and
data. A screen contains up to 40 characters of text and data. An alarm can be either
1 or 2 lines.)

-- A screen or alarm for the TD 100C displays up to four lines of text that provide
information for the operator. (Each line can contain either 12 or 16 characters of text
and data. A screen contains 48 or 64 characters of text and data. An alarm can be
either 1 or 2 lines.)

The textual message of the screen or alarm can convey information for the operator and
can also allow the operator to interact with the S7-200 CPU by changing the embedded
value of a variable (such as a set point or limit).

You can configure the TD device to display screens (which are initiated by operator action) and
bit-enabled alarms (which are generated by the S7-200 CPU). You can also configure the
TD 200C and the TD 200 device to display an icon to alert the operator of some event or action
required. (Refer to Chapter 4 for information about configuring the TD device.)

Tip
Pressing ESC returns you to the previous menu. If there is no activity for 20 seconds (no button
pressed), the TD device returns to the default display mode.

The operator uses the buttons on the keypad to navigate through the menu or a list of text.
Figure 5-3 shows the buttons that an operator could use to navigate from a user menu to the
screens associated with that item in the menu. Figure 5-4 shows how to navigate through the
alarms. The TD 200C and the TD 200 have eight menus available, and the TD 100C has four
menus available.

User menu item 1

User menu item 4

User menu item 5
User menu item 6

ENTER displays
the screens

The UP Arrow: scrolls up
through the list and wraps
to the last item

Enter

ESCESC returns to
the user menu

User menu item 2

The DOWN Arrow scrolls
down through the list and
wraps to the first screen

The DOWN Arrow scrolls down
through the list and wraps to
the first item

User menu item 7
User menu item 8

The UP Arrow: scrolls up
through the list and wraps to
the last screen

User menu item 3 Screen 1
Can be interactive

Screen 2
Can be interactive

Screen 3:
Can be interactive

Screen 4:
Can be interactive

Figure 5-3 Using the Keypad to Navigate between User Menus and Screens
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Alarm (highest priority)

Alarm

Alarm (lowest priority)

The UP Arrow: scrolls up through
the list of alarms and wraps to the last
alarm

Alarm

The DOWN Arrow scrolls down through
the list of alarms and wraps to the first
alarm

Alarm

S7-200 CPU

ENTER acknowledges the alarm and
resets the alarm bit in the S7-200 CPU

When an alarm bit turns on, the
S7-200 CPU writes the associated
alarm message to the TD device

EnterThe TD device lists the alarms
according to priority

Figure 5-4 Displaying and Acknowledging Alarms

Using the TD Device to Edit Variables in the S7-200 CPU
A screen or alarm message can contain an embedded variable field that allows an operator to
respond by changing the value of the variable. The operator uses the keypad to edit variables:

Selecting the Screen: The operator uses the UP or DOWN arrows to display the screen that
contains the variable to be edited. (From a menu, the operator presses ENTER to access
the group of screens.)

Navigating to the variable: The operator presses ENTER to navigate to the first editable
variable.

Changing the value of the variable: Pressing the UP arrow increments (increases) the
value, and pressing the DOWN arrow decrements (decreases) the value. (Pressing and
holding the UP or DOWN arrow accelerates the operation.) Pressing both SHIFT+ENTER
resets the variable to 0. Pressing ESC aborts the edit.

Press LEFT or RIGHT to move the cursor position within the variable. The TD 200 uses
SHIFT+UP to move left and SHIFT+DOWN to move right.

Updating the data in the S7-200 CPU: Pressing ENTER writes the updated value for the
variable to the S7-200 CPU and moves the cursor to the next editable variable on the
screen.

For more information about editing variables, see the section Editing a Variable that is Embedded
in an Alarm or a Screen in this chapter.



SIMATIC Text Display (TD) User Manual

68

Accessing the Menus and Screens
When you configured the TD device (as described in Chapter 4), you created the screens and
alarms for the TD device. If you configured both alarms and screens, you also designated which
type of message (screens or the alarms) would be the default display mode for the TD device.
After power-up or after a period of inactivity, the TD device returns to the default display mode.

In addition to the screens and alarms that you configured, the TD device provides standard
functions that the operator can access from system-level and pre-defined menus. From the default
display mode, the operator uses ESC to access the menu hierarchy. The operator then presses
ENTER to select the menu item for accessing the other menus or functions. Figure 5-5 and
Figure 5-6 show the hierarchy of menus for these functions for the TD devices. (The menus show
all of the functions that are available on the TD device. For some of the functions to be listed on
the menu, you must have enabled the function during configuration. See Chapter 4.)

Diagnostic Menu

TD Setup
View Messages
Force I/O
Change CPU Mode
Make Memory Cartridge
Edit CPU Memory

Alarms (Can be configured as
default screen)

ESC
Press ESC to display the
Main Menu

ESC
Press ESC to display the
Main Menu

Operator Menu

Secondary Display

Press ESC to display the User
Menu (of the screens)

Screens
(Default screen)

Default Display Mode

Press ESC to display the
Main Menu

User Menu (of the Screens)

Screens 1
Screens 2
(Up to 8 entries)

ESC
Press ESC to return to the
default display mode

Main Menu

CPU Status
Set Time and Date
Set Language

ESC
Press ESC to display the
Main Menu

ESC

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

ESC

Figure 5-5 Menu Hierarchy for the TD 200 and TD 200C
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Alarms (Can be configured as
default screen)

ESC
Press ESC to display the
Main Menu

Secondary Display

Press ESC to display the User
Menu (of the screens)

Screens
(Default screen)

Default Display Mode

Press ESC to display the
Main Menu

User Menu (of the Screens)

ESC

ESC

Menu

Display Alarms
CPU Status
Set Time
Release Password
Clean Keypad
TD Setup

ESC
Press ESC to return to the
default display mode

Screens 1
Screens 2
Screens 3
Screens 4

Figure 5-6 Menu Hierarchy for the TD 100C
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Entering and Releasing a Password
You use the Text Display wizard of STEP 7--Micro/WIN to configure the password for the
TD device. Refer to Chapter 4 for information about configuring the TD device. To ensure that an
unauthorized user does not have access to the TD device during an interval for the automatic
time-out, you can use the Release Password feature.

Certain operations (such as forcing I/O or making a memory cartridge) may also require that the
operator enter the 8-character CPU password for the S7-200 CPU. (You must have enabled the
S7-200 CPU for password-protection in order for the TD device to prompt the operator for the
CPU password.)

Entering the Password
If configured for a password, the TD device prompts the operator to enter the 4-digit password
before allowing the operator to access screens or menus. If the password uses fewer than 4
digits, the operator must press ENTER for the unused (remaining) characters.

Use the UP or DOWN arrow to select each digit of the password, pressing ENTER to move to the
next digit. You can also use the RIGHT and LEFT arrows to move within the password.

The TD device provides a time-out feature which automatically restores password protection after
a period of inactivity. If no buttons have been pressed after 2 minutes, the TD device then requires
a password again before allowing an operator to access menus or to edit variables.

Releasing the Password
In order to provide additional security for your application, the TD device provides a Release
Password command that immediately restores the password-protection. The TD device then
requires that the operator enter the password before allowing access. The Release Password
command prohibits another person from using the TD device without first entering a password (for
example, before a password entered by an operator times out).

You access the Release Password command from the main menu, as shown in Figure 5-7.

The Release Password is not applicable for the CPU
password: The TD device releases the CPU password
as soon as the operator exits the function that required
the password.

For example: If the operator entered the CPU password
in order to force an I/O point in the S7-200 CPU, the
TD device releases the CPU password as soon as the
operator exits the Force menu

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

operator exits the Force menu.
Figure 5-7 Release Password Command

The Release Password command is available only if you defined a 4-digit password when you
configured the TD device.
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Viewing the Screens and the Alarms
As described in Chapter 4, you can configure screens and alarms for the TD device. If you
configure both alarms and screens, you also designate which set of messages (screens or
alarms) are the default display mode for the TD device. The default configuration selects the
screens to be the default display.

After power-up or after a period of inactivity (one minute), the TD device returns to the default
display mode. As shown in Figure 5-8 and Figure 5-9, the operator can switch between the default
display mode and the secondary display mode.

Tip
For the TD 100C and the TD 200C: If you do not configure buttons for ESC or ENTER, you
cannot access the main menu.

Alarm message

Use the UP or DOWN arrow
buttons to scroll through the list
of alarm messages

Press ESC to display the
Main Menu

Bit-Enabled Alarms

Press ESC to display the User
Menu (of the screens)

Screen 1

Use the UP or DOWN arrow
button to scroll through the
screens for this group

Screens
Press ESC to display the
Main Menu

User Menu

User menu item 2
...

Press ESC to display the
default display

Operator Menu
Diagnostic Menu
Release Password

(Up to 8 entries)

TD 200C and TD 200 Screens: Up to 8 Screens Each for Up to 8 Groups

Secondary Display

Display Alarms

User menu item 1 Enter

ESC

ESC

Default Display Mode

Main Menu

ESC

ESC

Enter

Figure 5-8 TD 200C and TD 200 -- Navigating between the Default and Secondary Displays
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Alarm message

Use the UP or DOWN arrow
buttons to scroll through the list
of alarm messages

Press ESC to display the
Main Menu

Bit-Enabled Alarms

Press ESC to display the User
Menu (of the screens)

Screen 1

Use the UP or DOWN arrow
button to scroll through the
screens for this group

Screens
Press ESC to display the
Main Menu

User Menu

User menu item 2
...

Press ESC to display the
default display

(Up to 4 entries)

TD 100C Screens: Up to 8 Screens Each for Up to 4 Groups

Secondary Display

User menu item 1 Enter

ESC

ESC

Default Display Mode

Main Menu

ESC

ESC

Display Alarms
CPU Status
Set Time
Release Password
Clean Keypad
TD Setup

Display Alarms Enter

Figure 5-9 TD 100C -- Navigating between the Default and Secondary Displays

Displaying the Alarms
If you created both screens and alarms when you configured the TD device, the main menu of the
TD device includes a command that allows you to access the secondary (non-default) display.
The TD device always returns to the default display mode after a period of inactivity.

As shown in the TD 200C example in Figure 5-10, the
main menu provides a Display Alarms command for the
default TD configuration. If you configured alarms as
the default display, the main menu lists a User Menu
entry.

After displaying the alarms, you use the UP and DOWN
arrows to scroll through the sequential list of alarms.

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

Figure 5-10 Displaying the Alarms

Tip
The TD 100C and the TD 200C allow you to configure a button specifically for displaying alarms
when you are creating your custom keypad.
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The TD device displays the highest priority alarm. The TD device displays an up or down arrow
with the alarm to alert the operator that other alarms have been enabled. (The up arrow shows
that higher-priority alarms have been enabled, and the down arrow shows that lower-priority
alarms have been enabled.)

After reading a new alarm from the S7-200 CPU, the TD device sorts the alarms again to display
the highest priority alarms at the top of the list. The TD device determines the priority based on the
sequence of the alarms in the parameter block:

The first alarm that you created has the highest priority.

The second alarm that you created has the second-highest priority.

The last alarm that you created has the lowest priority.

Tip
You can scroll up and down through the list of enabled alarms. However, the TD device returns
to the highest-priority alarm after a period of inactivity: If you have not pressed a button for 10
seconds while the TD device has displayed the current alarm, then the TD device automatically
returns to the highest-priority alarm.

Acknowledging an Alarm
If an alarm requires acknowledgement, the TD device does not remove that alarm until you
acknowledge the alarm:

1. Use the UP or DOWN arrow to select the alarm.

2. Press ENTER to acknowledge the alarm.

Types of Alarms
The Text Display wizard allows you to determine the type interaction required by the operator for
an alarm. If the user screens are set as the default display mode for the TD device and an alarm is
enabled, an alarm indicator will begin to flash on the TD display. The indicator is large if there is an
alarm enabled that requires acknowledgement. The indicator will be small if the alarms do not
require acknowledgement. The user can switch to the alarm display to view the alarms.

The alarm display will show one or more alarms in priority order. An UP or DOWN arrow in the
right-most character position indicates more alarms are active, but not visible on the display. The
operator can press either the UP or the DOWN arrow key to scroll through the other enabled
alarms.

The operator can edit or accept variable values by pressing the ENTER key. The TD device will
write the updated variable value to the CPU and set the edit notification bit for that variable when
the operator presses the ENTER key. The TD device then moves the cursor to the next editable
variable. Pressing ENTER for the last editable variable of an alarm writes this last value to the
S7-200 CPU and the TD device then resets the alarm enable bit. For more information on editing
variables, see Editing a Variable that is Embedded in an Alarm or a Screen in Chapter 5.
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Every alarm falls into one of four possible alarm acknowledgement and editing types. This section
explains specifically how each alarm type is handled by the TD device. The four alarm types
follow:

No acknowledgement required. No edits allowed

Acknowledgement required. No edits allowed

No acknowledgement required. Edits allowed

Acknowledgement required. Edits allowed

No Acknowledgement Required, No Edits Allowed
In this combination of no acknowledgement required and no edits allowed, the TD device simply
displays the alarm. The ENTER key has no function since there are no editable variables within
the alarm. The alarm may contain variables that are updated at the update rate of the TD device.
This type of alarm is replaced on the display if a higher priority alarm is enabled by the S7-200
CPU. The operator can either press the UP or the DOWN arrow key to scroll to other alarms or
press ESC to return to the menus.

The TD device does not clear the corresponding alarm-enable bit in the S7-200 CPU.

Acknowledgement Required, No Edits Allowed
In this combination of acknowledgement required and no edits allowed, the TD device displays
the alarm and makes the entire alarm flash (blink) until the operator presses ENTER to
acknowledge the alarm. Variable values are updated from the S7-200 CPU at the normal update
rate while the alarm is flashing.

When the operator presses ENTER, the TD device:

Sets the acknowledgement-notification bit for this alarm.

Clears the alarm-enable bit for this alarm. This causes the alarm to be removed from the
display on the next update cycle.

Another alarm cannot replace the one flashing until the operator acknowledges the flashing alarm.
This is also true even if a higher priority alarm is enabled in the S7-200 CPU. If the TD device is
configured for single line alarms and the CPU enables a higher priority alarm, the flashing alarm
shifts down to the next line of the display. The operator cannot press the UP or the DOWN key to
scroll through other enabled alarms until the current alarm is acknowledged.

No Acknowledgement Required, Edits Allowed
In this combination of no acknowledgement required and edits allowed, the TD device displays a
alarm and then waits for the operator to edit a value in the alarm. All of the variables within the
alarm are updated at the update rate. Since the alarm does not require acknowledgement, this
type of alarm is removed from the TD device display if a higher priority alarm is enabled in the
S7-200 CPU.

Acknowledgement Required, Edits Allowed
In this combination of acknowledgement required and edits allowed, the TD device displays the
alarm, causes the entire alarm to flash (blink), and then waits until the operator acknowledges the
alarm and edits or accepts the values in the alarm. This type of alarm requires that the operator
edits or accepts the values displayed in the alarm. If the operator aborts the edit by pressing the
ESC key before editing all the values in the alarm, the alarm flashes to indicate that edits are still
required.

When the alarm is enabled in the S7-200 CPU, the TD device notes this and, if there is space
available on the display, reads the alarm from the CPU. The TD device then displays the alarm
and causes the entire alarm to flash to notify the operator that the alarm is present and must be
acknowledged.
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Clearing an Alarm
If an alarm required acknowledgement, the TD device will clear the alarm enable at the
same time that the Alarm Acknowledgement bit is set in the CPU.

If an alarm contains editable variables, the TD device will clear the alarm enable bit when all
of the edits are completed and the last editable variable in the messages is written to the
CPU.

The PLC program logic may clear the alarm enable bit at any time. This will remove the
alarm message from the TD display. An alarm message will not be removed from the
display if the user is editing a variable in the message or if the message has not yet been
acknowledged.

If the message does not require acknowledgement and/or does not contain editable
variables, then the CPU program logic MUST clear the alarm enable bit.

Editing a Variable that is Embedded in an Alarm or a Screen
If you configured a screen or an alarm to include a variable, you can enter a new value for the
variable:

Use ENTER to move the cursor to the the variable. The TD device will write the updated
variable value to the CPU and set the edit notification bit for that variable when the operator
presses the ENTER key, completing the edit of the variable.

Use the UP or DOWN arrows to change the value of the variable.

Use the following buttons to move the cursor to different characters within the variable:

-- TD 100C and TD 200C: LEFT and RIGHT arrows

-- TD 200: SHIFT+UP arrow and SHIFT+DOWN arrow

ESC rereads the value of the variable from the S7-200 CPU and redisplays the value.

ENTER writes the new value to the S7-200 CPU. (If the alarm contains other variables, the
cursor moves to the next variable.) The TD device will write the updated variable value to
the CPU and set the edit notification bit for that variable when the operator presses the
ENTER key, completing the edit of the variable.

If the variable was configured as a numeric string, the cursor skips over any non-numeric
characters in the message. See Chapter 4. After you have edited all of the variables in an alarm,
the TD device resets the alarm bit in the S7-200 CPU.

Notice
Due to restrictions in the format used to store real (floating-point) numbers in both the S7-200
CPU and the TD device, the accuracy of the number is limited to six significant digits. Editing a
real number with more than six digits may not change the value of the variable, or may cause
other digits within the number to change:

Changing the least significant (right-most) digit of a real-number variable with more than six
digits may have no effect. For example, if you try to change the “9” in “1234.56789”, the
value of the variable does not change.

Changing the most significant (left-most) digit of a real-number variable with more than six
digits may cause other (less significant) digits in the variable to change.
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TD Bit Usage
A summary of the TD bit usage is shown in Table 5-1.

Table 5-1 Summary of TD Bit Usage

Bits Associated
with Alarms and
Screens

Enable Condition
for the Bit

Results shown on the TD Display Clear Condition for the Bit

ALARM ENABLE The alarm must be
enabled with the
TD_ALRM
instruction using the
Alarm Symbolic
Name as the
instruction input.

When an alarm is enabled and the TD default
display mode is set to the alarm mode, the
alarm message is placed on the TD display.
If there are multiple alarms enabled, the
highest priority alarm is displayed.

If an alarm requires user acknowledgment,
the message will flash (blink) until it is
acknowledged by the user. The alarm MUST
be acknowledged before other alarms can be
viewed. An alarm that requires
acknowledgement will not be replaced on the
display by higher priority alarms until the
alarm is acknowledged.

If the alarm contains editable variables the
user can edit or accept the values (by
pressing the ENTER key). If the edits are not
completed, and the alarm message required
acknowledgement, the message will again
begin to flash.

If the user screens are set as the default
display mode for the TD device and an alarm
is enabled, an alarm indicator will begin to
flash on the TD display. The indicator is large
if there is an alarm enabled that requires
acknowledgement. The indicator will be small
if the alarms do not require
acknowledgement. The user can switch to
the alarm display to view the alarms. The
alarms will be presented to the user in priority
order.

There are different ways to
clear the alarm enable bit:

If an alarm required
acknowledgement, the TD
device will clear the alarm
enable at the same time that
the ’Alarm
Acknowledgement’ bit is set
in the CPU.

If an alarm contains editable
variables, the TD device will
clear the alarm enable bit
when all of the edits are
completed and the last
editable variable in the
messages is written to the
CPU.

The PLC program logic may
clear the alarm enable bit at
any time. This will remove
the alarm message from the
TD display. An alarm
message will not be
removed from the display if
the user is editing a variable
in the message or if the
message has not yet been
acknowledged.

If the message does not
require acknowledgement
and/or does not contain
editable variables, then the
CPU program logic MUST
clear the alarm enable bit.

ALARM
ACKNOW--
LEDGE

Alarm
acknowledgement is
available only if the
wizard configuration
has the option
enabled for this
alarm: Alarm should
require operator
acknowledgement

The user acknowledges an alarm message
by scrolling to the message an pressing the
ENTER key. The TD device will then set the
acknowledge notification bit in the CPU and
the alarm message will stop flashing
(blinking).

If there are no editable variables in the
message the TD device will also clear the
alarm enable bit for this message.

If there are editable variables in the
message, the user must either edit the
variables (change them and press ENTER)
or accept the current values (press ENTER).
When the last variable in the message is
edited or accepted, the TD device will write
the variable to the CPU and clear the alarm
enable bit.

If the user does not complete editing the
variables in the message, the TD device will
begin to flash (blink) the message to notify
the user that an action is still pending.

The TD device will set the
alarm acknowledge bit. The
user program logic must
clear the alarm
acknowledgement bit.
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Table 5-1 Summary of TD Bit Usage

Clear Condition for the BitResults shown on the TD Display
Enable Condition
for the Bit

Bits Associated
with Alarms and
Screens

ALARM
MESSAGE:
EMBEDDED
VARIABLE EDIT
NOTIFICATION

The edit notification
is available only
when the alarm
contains a variable
and the user has
enabled the Wizard
option to allow
editing of the
variable. ”Operator
is allowed to edit
this data”. If the
alarm message
contains multiple
editable variables,
each variable has a
unique edit
notification bit.

The TD device will write the updated variable
value to the CPU and set the edit notification
bit for that variable when the operator
presses the ENTER key, completing the edit
of the variable.

The user program can
monitor the edit notification
bit to recognize when an
editable value has been
changed by the operator.
The user program can then
take some action based on
the new value for the
variable.

The user program must
clear the edit notification bit
so that subsequent edits can
be recognized.

USER SCREEN:
EMBEDDED
VARIABLE EDIT
NOTIFICATION

The edit notification
is available only
when the user
screen contains a
variable and the
user has enabled
the Wizard option to
allow editing of the
variable. ”Operator
is allowed to edit
this data”.

If the user screen
contains multiple
editable variables,
each variable has a
unique edit
notification bit.

The TD device will write the updated variable
value to the CPU and set the edit notification
bit for that variable when the operator
presses the ENTER key, completing the edit
of the variable.

The user program can
monitor the edit notification
bit to recognize when an
editable value has been
changed by the operator.
The user program can then
take some action based on
the new value for the
variable.

The user program must
clear the edit notification bit
so that subsequent edits can
be recognized.
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Performing Typical or Routine Operator Tasks
The Operator Menu allows you to perform the following
tasks:

Determining the model and version of the S7-200
CPU (CPU Status)

Viewing the error messages generated by the
S7-200 CPU (CPU Status)

Setting the time in the S7-200 CPU (Set Time
and Date)

Selecting a language set for the TD device (Set
Language) (TD 200 and TD 200C only)

CPU Status
Set Time and Date
Set Language

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

Figure 5-11 Operator Menu for TD 200C
and TD 200

Viewing the Status of an S7-200 CPU
The CPU Status command allows you to display the following information:

Model and version of the S7-200 CPU

Error messages generated by the S7-200
CPU

After you select the CPU Status command, the
TD device displays the CPU model and version.

Press the UP or DOWN arrows to display the error
messages that were generated by the S7-200 CPU.

The TD device displays an error message only if an
error exists in the S7-200 CPU. The CPU classifies
errors as either fatal errors or non-fatal errors.

Display Alarms
CPU Status
Set Time
Release Password

errors as either fatal errors or non-fatal errors.
Figure 5-12 CPU Status Menu for TD 100C
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Table 5-2 lists the error messages that can be displayed by the TD devices. Refer to the SIMATIC
S7-200 Programmable Controller System Manual for information about specific errors.

Table 5-2 Error Messages Relating to the Status of the S7-200 CPU

Type Message Description

Fatal Program Checksum Error Hardware failure (S7-200 CPU)

Compare Contact User program error: Illegal Compare contact

EEPROM/Permanent Memory
Failure

Hardware failure (S7-200 CPU)

Memory Cartridge Failure Memory cartridge failure

Scan Watchdog Timeout Hardware failure (S7-200 CPU)

Unknown Error XXXX
(where XXXX = the error number)1

CPU failure (S7-200 CPU)

Non-Fatal I/O Error Mod X
(where X = the number of the I/O
module)

An expansion module encountered an I/O error.

If there are multiple failures, the TD device displays this
message multiple times one time for each failed
module.

Runtime Error XXXX
(where XXXX = the error number)1

The S7-200 CPU encountered an error while executing
the user program, such as:

Indirect addressing

HSC setup and execution errors

Attempting to execute an illegal instruction (ENI,
DISI, or HDEF) inside an interrupt routine

Subroutine nesting errors

TODW data errors

Simultaneous Transmit (XMT) and Receive (RCV)
errors

1 Refer to the SIMATIC S7-200 Programmable Logic Controller System Manual for information about the specific
error.
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Setting Time and Date in the S7-200 CPU
You can use the TD device to change the time-of-day settings in the S7-200 CPU. This allows an
operator to easily adjust for time changes.

The TD device does not maintain time and date settings. In order to display the time and date
values, the TD device reads the current time and date from the S7-200 CPU and displays these
values. The operator can then use this screen to edit these values and then write the new time
and date settings back to the S7-200 CPU.

Tip
The TD device does not validate the time, date or day of the week values that you enter. You
can inadvertently write an incorrect date or day of the week to the S7-200 CPU.

To allow an operator to change the time and date settings in the S7-200 CPU:

You must have enabled (selected) the time-of-day (TOD) option when you configured the
TD device with the Text Display wizard. Refer to Chapter 4.

The S7-200 CPU must support the TOD clock.

Tip
If you configured a password for the TD device, the operator must enter the password before
being allowed to set the time and date.

If the TD device was not configured to allow changes to
the time or if the S7-200 CPU does not support the
TOD clock, the Set Time and Date command does not
appear on the Operator Menu.

After you select the Set Time command, the TD device
reads the current date and time from the S7-200 CPU.

The Time and Date screen displays the following
information:

Date: day--month--year (for Chinese, the date is
displayed as year--month--day)

Time

Day of the week

CPU Status
Set Time and Date
Set Language

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

Day of the week
Figure 5-13 Setting the Time and Date on

the TD 200C and TD 200

Use the UP or DOWN arrow buttons to change the values in the fields.

Use the ENTER to move to the next field. (For a
TD 100C and TD 200C, you can also use the RIGHT
arrow. For a TD 200, you can use the SHIFT+DOWN
arrow.)

Use the ESC to move back to the first field. (For a
TD 100C and TD 200C, you can also use the LEFT
arrow. For a TD 200, you can use the SHIFT+UP
arrow.)

Display Alarms

Release Password

CPU Status
Set Time

arrow.)
Figure 5-14 Setting the Time and Date on

the TD 100C

Pressing ENTER when the cursor is located on the last field of the Time and Date screen writes
the new time and date values to the S7-200 CPU and returns to the Operator Menu.

Pressing ESC when the cursor is located on the first field of the Time and Date screen returns to
the Operator Menu.
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Changing the Language Set (TD 200C and TD 200 only)
You can use the TD device to change the language set in order to localize the TD device for
another country. You must have created different language sets for your alarms and screens when
you configured the TD device with the Text Display wizard. Each language set that you configure
selects the language for the system menus and prompts of the TD device, as well as the screens
and alarms. Refer to Chapter 4 for information about configuring language sets for the TD device.

As shown in Figure 5-15, selecting the Set Language command displays a menu of the languages
that you configured with the Text Display wizard. Use the UP or DOWN arrows to select the
language to be displayed by the TD device.

CPU Status
Set Time and Date

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

Language 1
Language 2
...
(configured languages)

Set Language

Figure 5-15 Selecting One of the Language Sets Configured for the TD Device

Cleaning the Keypad
The Clean Keypad function disables the keypad for 30 seconds to allow you to clean the keypad
without affecting TD operation. The TD device displays a count down timer that shows the
remaining seconds.
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Performing Specialized Operator Tasks (Diagnostic/Setup Menu)
Some of the pre-configured tasks provided by the TD device provide assistance with setting up
the TD device or troubleshooting problems with the S7-200 CPU. These functions are typically
accessed infrequently. See Figure 5-16 and Figure 5-17.

Display Alarms
Operator Menu
Diagnostic Menu
Release Password

TD Setup
View Messages
Force I/O
Change CPU Mode (TD 200C)
Make MC (TD 200C)
Edit CPU Memory (TD 200C)

TD Address
CPU Address
Parameter Block Address

Baud Rate
Highest Station

Gap Factor
Contrast

S7-200 password required
(if configured)

Force Input
Force Output
Unforce All I/O

Figure 5-16 TD 200C and TD 200 Diagnostic Menu Hierarchy

CPU Status

Release Password

Set Time

TD Setup

Clean Keypad

Figure 5-17 TD 100C Diagnostic Menu Hierarchy

Tip
If you are using a custom keypad that does not support the ENTER and ESC buttons, you must
use the standard keypad to set up the TD device.

To restore the standard TD keypad:

1. Power down the TD device

2. Press and hold the lower right corner (where ENTER key is located on the standard
keypad)

3. Power up the TD device

The default keypad is restored until the TD device is power cycled again.
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Setting up the TD Device
As shown in Figure 5-18, you use the TD Setup menu to configure various parameters for the
TD device, such as network addresses, address of the parameter block (stored in V memory of
the S7-200 CPU), baud rate, and other communication parameters.

Setting the network address for the TD device:
Use the UP or DOWN arrow to set the network
address (default address = 1).

Setting the CPU address: Use the UP or DOWN
arrow to select the network address for the
S7-200 CPU (default = 2).

Setting the address for the parameter block:
Designates a V memory location where the
parameter block (or an offset to the location of the
parameter block) is stored in the S7-200 CPU.
Setting the address of the parameter block allows
you to connect multiple TD devices to a single
S7-200 CPU.

Use the UP or DOWN arrow to select the starting
V memory address of the parameter block that
stores the configuration of the TD device.

The address of the parameter block must match
the address that you configured in the
S7-200 CPU (address range: VB0 to VB32000,

TD Setup
View Messages
Force I/O
Change CPU Mode
Make MC
Edit CPU Memory

TD Address
CPU Address
Parameter Block Address
Baud Rate
Highest Station
Gap Factor
Contrast

S7 200 CPU (address range: VB0 to VB32000,
default = VB0). Figure 5-18 TD Setup Menu

Setting the baud rate for the TD device: choose the baud rate for the TD device. You can
choose either 9.6 kbaud (9600 baud), 19.2 kbaud, or 187.5 kbaud.

Use the UP or DOWN arrow to select the baud rate. The baud rate must match the baud
rate of the S7-200 CPU and any other device on the same network.

Setting the Highest Station: Changes the highest station address for the TD device. This
setting tells the TD device which network addresses to check when looking for other
network master devices. The default highest station address is 31. This means that the
TD device checks addresses 0 through 31 when looking for other network masters. This
setting should only be changed when there are more than 32 master devices on the
network.

Use the UP and DOWN arrows to select the highest address on the network (default = 31)

Setting the Gap Factor: Changes the Gap Factor for the TD device. This setting tells the
TD device how often to check for other network master devices. The default setting of 10
causes the TD device to check once every 10 messages. A setting of 1 would cause the
TD device to check for other masters after every message.

Use the UP and DOWN arrows to select the gap factor between stations (default = 10)

Set the contrast: You can optimize the display for different viewing angles and lighting
conditions by adjusting the contrast of the screen on the TD device. The default contrast
value is 40, with values ranging from 25 (lighter) to 55 (darker).

Use the UP and DOWN arrows to select the contrast setting for the display area of the
TD device (default setting = 40)

Tip
At 9600 baud or 19.2 kbaud, the highest station address may need to be increased, even
though the network does not contain more than 32 masters. Increasing the highest station
address allows more time for the masters to transmit messages.
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Viewing the TD Messages Stored in the S7-200 CPU
(TD 200C, TD 200 only)

You can review all of the TD messages (screens and alarms) that you configured for the
TD device within the language set currently selected for the TD device.

The View Messages command allows you to verify that
all of the alarms and screens were correctly stored in
the S7-200 CPU.

The View Messages command does not allow you to
edit any values that are displayed in the messages.

Selecting the View Messages command displays all of
the messages and process values stored in the
S7-200 CPU. Use the UP and DOWN arrows to scroll
through messages stored in the S7-200 CPU.

TD Setup
View Messages
Force I/O
Change STOP/RUN Mode
Make MC
Edit CPU Memory

through messages stored in the S7 200 CPU.
Figure 5-19 View Messages Command

Forcing the Inputs and Outputs in the S7-200 CPU
(TD 200C, TD 200 only)

The Force I/O menu allows you to force inputs, force outputs, or unforce all inputs and outputs.
The Force I/O command is available only if you enabled the force-menu when you configured the
TD device with the Text Display wizard.

Caution
Turning off the power to the S7-200 CPU before the force information is written to the permanent
memory in the CPU can cause the S7-200 CPU to experience a failure the next time you turn
the S7-200 CPU on.

To clear the error condition, use the TD device to either unforce all of the I/O points or else
rewrite the force information to the S7-200 CPU. Cycling the power to the S7-200 CPU should
clear the error.

If the S7-200 CPU requires a password before allowing
the I/O to be forced, the TD device prompts the
operator to enter the 8-character CPU password.

The Force I/O command provides the following options:

Force Inputs: Allows you to force individual
inputs on or off, or to turn off the Force function

Force Outputs: Allows you to force individual
outputs on or off, or to turn off the Force function

Unforce All I/O: Allows you to turn off the Force
function for all of the forced I/O points

Use the UP or DOWN arrow to select the specific I/O
point. Pressing ENTER moves the cursor to the Force
options. (For a TD 200C, you can also use the RIGHT
arrow. For a TD 200, you can use the SHIFT+DOWN
arrow.)

TD Setup
View Messages
Force I/O
Change CPU Mode
Make MC
Edit CPU Memory

Force Inputs
Force Outputs
Unforce All I/O

Use the UP or DOWN arrow to select the type of force
condition for the selected I/O point.

Figure 5-20 Force I/O Command

Tip
Unforcing the I/O points does not place them in the OFF state. Unforcing only removes the
Force option. The points remain in their last state until you manually change them or they are
changed by the user program in the S7-200 CPU.
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Changing the Operating Mode of the S7-200 CPU (TD 200C Only)
The Change STOP/RUN Mode command is only available for the TD 200C and is only available if
you selected this function when you configured the TD 200C with the Text Display wizard. See
Chapter 4.

You can use the TD 200C to change the operating mode of the S7-200 CPU from STOP to RUN
or from RUN to STOP. The operator may need to enter the TD password, if the TD 200C is
configured for password-protection.

In order to allow the TD 200C to change the operating
mode, the mode selector switch on the S7-200 must be
set to either RUN or TERM.

The TD 200C cannot change the operating mode if the
mode selector switch is set to STOP.

TD Setup
View Messages
Force I/O
Change STOP/RUN Mode
Make MC
Edit CPU Memory

Figure 5-21 Changing the Operating Mode

Copying the User Program to a Memory Cartridge (TD 200C Only)
The Make MC (memory cartridge) command is only available for the TD 200C and only if you
selected this function when you configured the TD 200C with the Text Display wizard. See
Chapter 4.

You can use the TD 200C to copy the user program in the S7-200 CPU to a memory cartridge
(MC). The operator may need to enter both the TD password and the CPU password, if both the
TD 200C and the S7-200 CPU are configured for password-protection.

Before attempting to write the user program to the
memory cartridge, ensure that you have installed a
memory cartridge in the S7-200 CPU.

After you select the Make MC command, the TD 200C
alerts you that this operation will erase any existing
data on the memory cartridge. Press the DOWN arrow
to continue.

After reading the message, press ENTER to continue
or press ESC to abort the operation.

TD Setup
View Messages
Force I/O
Change STOP/RUN Mode
Make MC
Edit CPU Memory

or press ESC to abort the operation.
Figure 5-22 Making a Memory Cartridge



SIMATIC Text Display (TD) User Manual

86

Editing the CPU Memory (TD 200C Only)
The Edit CPU Memory command is only available for the TD 200C and only if you selected this
function when you configured the TD 200C with the Text Display wizard. See Chapter 4.

You can use the TD 200C to edit the values stored in
the memory of the S7-200 CPU. The operator may
need to enter the TD password, if the TD 200C is
configured for password-protection.

After you select the Edit CPU Memory command
(Figure 5-23), the TD 200C displays the Edit CPU
Memory screen.

As shown in Figure 5-24, you press ESC to edit the
data in the memory address. The TD 200C places a
cursor on the memory area.

TD Setup
View Messages
Force I/O
Change STOP/RUN Mode
Make MC
Edit CPU Memory

cursor on the memory area.
Figure 5-23 Edit CPU Memory Command

To edit the memory address: Use the UP or DOWN arrows to change the memory address.
(Use the RIGHT or LEFT arrow keys to move between the fields of the memory address.)
Press ENTER to display the value of that memory address and to move the cursor to the
data type field.

To edit the data type: Use the UP or DOWN arrows to change the data type. Press ENTER
to display the value and to move the cursor to the value field.

To edit the value stored in the memory address: Use the UP or DOWN arrows to change
the value.

Press ENTER to write the new values to the memory address in the S7-200 CPU. Pressing ESC
aborts the function.

VW00000 (INT)

--12345

(INT) --12345V

ESC

Area

W

Size

00000

Address

Edit the memory address Edit the data type

Data type

Edit the value

Value

Enter

The UP and DOWN arrows
change the data in the
selected field

Press ESC to edit the
CPU memory

Press ENTER to write the new
value to the CPU memory

Enter Enter

Figure 5-24 Editing the Memory in the S7-200 CPU
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Table 5-3 lists the memory address and data types possible. For information about the memory
areas, sizes of the data, and data types supported by your S7-200 CPU, refer to the S7-200
Programmable Controller System Manual.

Use the UP and DOWN arrows to scroll through the list of valid entries for each field.

To change the numeric value displayed in the address and value fields:

Use the UP and DOWN arrows to adjust each digit in the value or address.

Use the LEFT and RIGHT arrows to move between the digits of the value or address.

Press ENTER to write the new value to the S7-200 CPU.

Tip
Binary values cannot be edited.

Table 5-3 Possible Values for the CPU Memory Address and Data Type

Field Description

Memory area V Variable memory area

M Bit Memory area

SM Special Memory area

T Timers Current value only1, INT only

C Counters Current value only1, INT only

I Inputs

Q Outputs

Memory size B (byte)

W (word)

D (double-word)

Address 0 to 32000 (limited by the memory for your S7-200 CPU)

Refer to the S7-200 Programmable Controller System Manual for the range of memory
supported by the different S7-200 CPU models)

Data type INT Integer (valid for Byte, Word or Double-word)

Byte values are displayed as unsigned integers
Word and Double-word values are displayed as signed integers

REAL Real or floating-point (valid for Double-word only)

The value displayed for a Real number is rounded to 6 or 7 significant digits. The
TD 200C displays the Real number in fixed-point format only (no scientific notation)

The TD 200C cannot display Real numbers larger than 18 digits and allows up to 7
decimal places. (For example: The TD 200C displays 0.00000005 as 0.0000001, and
displays real numbers less than 0.00000005 as “0.0”.)

The TD 200C writes the number displayed to the S7-200 CPU without rounding.

HEX Hexadecimal (valid for Byte, Word, and Double-word)

BIN Binary (valid for Byte and Word only)

Binary values are displayed in the same pattern (7..0) as discussed in the S7-200
Programmable Controller System Manual and displayed by the Status Chart of
STEP 7--Micro/WIN

Binary values cannot be edited

1 The TD 200C displays only the current value for timers and counters. To display preset values for timers or
counters, you must store these values in V memory. The TD 200C does not display the value of the timer or
counter bit.
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General Technical Specifications

Table A-1 Text Display Order Numbers

Order Number Description Dimensions (mm) (W x H x D) Weight

6ES7 272-- 1BA10--0YA0 TD 100C Operator Interface 89.6 x 76 x 35.7 0.11 kg

6ES7 272--0AA30--0YA0 TD 200 Operator Interface 148 x 76 x 28 0.19 kg

6ES7 272--1AA10--0YA0 TD 200C Operator Interface 148 x 76 x 28 0.20 kg

6ES7 272--1AF00--7AA0 TD 200C Blank faceplate material, A4 size (10 sheets/package)

6ES7 272--1BF00--7AA0 TD 100C Blank faceplate material, A4 size (10 sheets/package)

6ES7 901--3EB10--0XA0 TD/CPU cable1 3 meters 0.15 kg

1 If the TD 100C is purchased inside North America, the TD CPU cable is included with the TD 100C. If the TD 100C is purchased outside
North America, the cable must be ordered separately.

Table A-2 General Specifications

General
TD 100C
6ES7 272--1BA10--0YA0

TD 200
6ES7 272--0AA30--0YA0

TD 200C
6ES7 272--1AA10--0YA0

Keyboard Customizable faceplate
Supports up to 14 keys

Membrane keypad with 9
keys
Tab inserts for
customer--specific labeling

Customizable faceplate
Supports up to 20 keys

Display FSTN--Graphic Display with
132 x 65 (columns x rows),
no backlight

STN--Graphic Display with 181 x 33 (Columns x Rows),
LED backlight

PLC interface RS 485 (PPI); 9.6 / 19.2 / 187.5 Kbits/s

Supply voltage (UN) Supplied by the S7-200
CPU, no external supply,
(24 VDC (8 VDC ... 30 VDC)
safety extra low voltage,
NEC Class 2 or limited
power source)

24 VDC, 15 VDC ... 30 VDC, safety extra low voltage,
NEC Class 2 or limited power source (supplied by the
S7-200 CPU, mains adapter or a 24 VDC external
supply). The TD device has no integrated means of
protection against strong interference pulses in the
microsecond range (surge impulse). If the power being
supplied has no appropriate means of protection, then a
surge voltage protector should be pre-connected.

Current consumption (IN) Typical 20 mA, maximum 50
mA, at UN 24V (no fuse in
TD 100C)

Typical 70 mA, (terminating resistors switched off)
Maximum 120 mA at UN 24V (3.15A fuse in TD 200).

Inrush current Not applicable Maximum 0.6 A / 15 ms

Degree of protection IP 651 (mounted on front of
the panel)

IP 20 (mounted on casing)

IP 651 (mounted on front of the panel)

IP 20 (mounted on casing)

NEMA 41

Safety

Safety standard IEC61131--2, UL508,
CSA C22.2 No. 142

EN 60950, IEC 60950, UL 60950, CSA C22.2 No. 60950

Noise emission <45dB(A) to DIN 45635 (no fan)

1 To ensure compliance with IP 65 or NEMA 4:
The minimum panel thickness must be at least 1.5 mm.

The mounting screws on the TD device must be tightened to a torque of 0.7 N--m.

The gasket must be replaced whenever the TD device is removed and reinstalled.

To procure new gaskets, contact your Siemens distributor or sales representative.
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Table A-2 General Specifications, continued

TD 200C
6ES7 272--1AA10--0YA0

TD 200
6ES7 272--0AA30--0YA0

TD 100C
6ES7 272--1BA10--0YA0

General

Electromagnetic Compatibility (EMC) (tested with TD/CPU cable 6ES7 901--3EB10--0XA0)

Emitted interference
Limit class

B to EN 55022 = CISPR 22

Noise immunity on signal
lines

2kV according to IEC 61000--4--4 1000-4-4; Burst

Noise immunity to discharge
of static electricity

6kV Contact discharge (according to IEC 61000-4-2; ESD)

8kV Air discharge (according to IEC 61000--4--2; ESD)

Conducted interference on
DC power supply line

Not applicable 2kV according to IEC 61000--4--4; Burst

1kV according to IEC 61000--4--5; µs-impulse
(Surge); (line against line)

2kV according to IEC 61000--4--5; µs-impulse
(Surge); (line against earth)

Power supplies with the same voltage can only be used
with additional means of protection, for example, a surge
voltage protector available from the Dehn company, type
RZ/E 24 V-, order No. 917 204.

Noise immunity to high
frequency emission

10 V/m with 80% amplitude modulation at 1 kHz, 9 kHz to 80 MHz
(according to IEC 61000--4--6)

10 V/m with 80% amplitude modulation at 1 kHz, 80 MHz to 2 GHz
(according to IEC 61000--4--3)

Climatic conditions

Temperature

Operation

Storage/Transport

Tested according to IEC 60068--2--1, IEC 60068--2--2

0° C to +60°C (+32° F to +140 °F) (rate of temperature change max. 10 °C/h)

--20° C to +60 °C (--4° F to +140 °F) (rate of temperature change max. 20 °C/h

Relative humidity

Operation

Storage/Transport

Tested according to IEC 60068--2--78, IEC 600068--2--30

95% at 30 °C (no condensation)

95% at 55 °C (no condensation)

Mechanical Environmental Conditions

Vibration

Operation

Transport (packaged)

Tested according to
IEC 60068--2--6

5 Hz to 9 Hz,
amplitude, 3,5 mm

9 Hz to 150 Hz,
acceleration 9.8 m/s2

5 Hz to 9 Hz,
amplitude 3.5 mm

9 Hz to 500Hz,
acceleration 9.8 m/s2

Tested according to
IEC 60068--2--6

10 Hz to 58 Hz,
amplitude 0.075 mm

58 Hz to 150 Hz,
acceleration 9.8 m/s2

5 Hz to 9 Hz,
amplitude 3.5 mm

9 Hz to 500 Hz,
acceleration 9.8 m/s2

Shock

Operation

Transport (packaged)

Tested according to IEC 60068--2--27/29

Semisinusoidal: 150 m/s2 (15g), 11 ms

Semisinusoidal: 250 m/s2 (25g), 6 ms

Special Features

Quality assurance In accordance with ISO 9001

Servicing Maintenance-free (no battery)

Panel mounting Accessories for panel mounting are enclosed



SIMATIC Text Display (TD) User Manual

92

Certificates, Directives and Declarations

IEC 61131--2
The TD 100C text display satisfies the requirements and criteria of the IEC 61131--2 standard
(programmable controllers, part 2 on equipment requirements and tests).

Notes on the CE Symbol
The following applies to the SIMATIC product described in this operating instruction:

EMC Directive
This product fulfils the requirements for the EC directive 89/336/EEC on “electromagnetic
compatibility” and the following fields of application apply according to this CE symbol. See
Table A-3.

Table A-3 EMC Directive

Field of Application
Requirement for

Field of Application
Emitted Interference Noise Immunity

Residential, commercial areas and light
industrial environments

EN 61000--6--3 EN 61000--6--1

Industry EN 61000--6--4 EN 61000--6--2

ATEX Directive (Explosion Protection Guidelines)
This product fulfils the requirements for the EC directive 94/9/EEC on “ATEX”
(Devices and protection systems to be used as prescribed in potentially explosive
areas (Guidelines for Explosion Protection)” and was tested according to EN 50021
(Electrical apparatus tor potentially explosive atmospheres;Type of protection “n”).

II 3 G EEx nA II T3..T6

Declaration of Conformity
The EC declarations of conformity and the documentation relating to this are available to the
authorities concerned, according to the above EC directive, from:

Siemens AG
Bereich Automatisierungs- und Antriebstechnik
A&D AS RD ST
Fr. Zisler
Postfach 1963
D-92209 Amberg

Tel.: 09621 80 3283
Fax: 09621 80 3278

Observing the Setup Guidelines
The setup guidelines and notes on safety given in the manual must be observed on startup and
during operation.
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Approvals for USA, Canada and Australia
The characters stamped on a device are indicative of the requirements which that device meets:

Underwriters Laboratories: cULus Approval, Hazardous Location

CULUS Listed 21BP I.T.E. for Hazardous Location
Underwriters Laboratories Inc., according to:

TD 200 and TD 200C:

UL 60950 (Information Technology)

CSA C22.2 No. 60950 (Information Technology)

TD 100C:

UL 508 (Industrial Control Equipment)

CSA C22.2 No. 142 (Industrial Control Equipment)

UL 1604 (Hazardous Location)

CSA--213 (Hazardous Location)

APPROVED for Use in:

CI. 1, Div.2, GP. A, B, C, D, T5

CI. 1, Zone 2, GP.IIC, T5

Please see the note below:

Note:
This plant has to be mounted according to the NEC (National Electric Code)
stipulations.

When used in environments according to class I, division 2 (see above), the
SIMATIC TD device must be mounted in a housing that corresponds to at
least IP54 according to EN 60529.

C US

HAZ. LOC.

FM approval to Factory Mutual Approval Standard Class Number 3611, Class I,
Division 2, Group A, B, C, D, and Class I, Zone 2, Group IIC.
Temperature class T5 is adhered to when the ambient temperature during
operation does not exceed 60°C.

FM

APPROVED

Note for Australia: Our product fulfills the requirements for Norm AS/NZS CISPR22.

FM Approval Notes
FM approval, if present, is to Factory Mutual Approval Standard Class Number 3611, Class I,
Division 2, Group A, B, C, D, and Class I, Zone 2, Group IIC.

Temperature class T5 is adhered to when the ambient temperature during operation does not
exceed 60°C.

Warning
Personal injury or property damage can result if you do not follow FM hazardous location
guidelines.

In hazardous areas, personal injury or property damage can result if you close or disconnect an
electrical circuit during operation (for example, plug-in connections, fuses, switches).

Do not close or disconnect any live circuits unless explosion hazards can be definitely excluded.
Do not disconnect while the circuit is live unless the location is known to be non-hazardous.
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Standard TD Character Set (TD 200C, TD 200 only)

Table A-4 Standard TD Character Set for the TD 200C and the TD 200
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Table A-4 Standard TD Character Set for the TD 200C and the TD 200, continued

ALT Key Combinations for International and Special Characters
Certain international and special characters may not display correctly on the TD display if entered
with the Text Display wizard with the standard TD character set. For international and special
characters, use the ALT key and number combinations shown in Table A-5 to enter the characters
in the Text Display wizard.

Table A-5 ALT Key Combinations for International and Special Characters

Character ALT + Key Combination Character ALT + Key Combination

ü Alt+0129 ñ Alt+0164

ä Alt+0132 Ω Alt+0234

æ Alt+0145 Σ Alt+0228

Æ Alt+0146 Π Alt+0227

å Alt+0134 Alt+0157

ö Alt+0148 Alt+0195 (left arrow ←)

Å Alt+0143 Alt+0180 (right arrow →)

° Alt+0248 Alt+0200 (single bar)

α Alt+0224 Alt+0201 (double bar)

ß Alt+0225 Alt+0202 (triple bar)

ε Alt+0238 Alt+0203 (four bars)

N Alt+0230 Alt+0204 (five bars)

σ Alt+0229 ↑ Alt+0194 (up arrow)

¢ Alt+0155
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Bar Graph Character Set (TD 200C, TD 200 only)
Table A-6 shows the bar graph characters that are supported by the standard TD character set.

Table A-6 Bar Graph Character Set for the TD 200C and TD 200
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Arabic Character Set (TD 200C, TD 200 only)

Table A-7 Arabic Character Set for the TD 100C, TD 200 and TD 200C



SIMATIC Text Display (TD) User Manual

98

Baltic Character Set

Table A-8 Baltic Character Set for the TD 100C, TD 200 and TD 200C
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Simplified Chinese Character Set
The TD devices support the Simplified Chinese character set (GB2312--80) for the People’s
Republic of China. The TD devices use Microsoft Windows encoding for this character set. The
Windows encoding allows the TD devices to display the same characters as shown in the
STEP 7--Micro/WIN Text Display wizard when you are using a Chinese emulator or a Chinese
version of Microsoft Windows.

Chinese characters are represented in STEP 7--Micro/WIN by a pair of numbers which represent
the encoding of the character in the GB2312--80 specification. The TD devices also use a pair of
numbers to represent the Chinese character.

Notes for Using the Simplified Chinese Character Set

Tip
The Simplified Chinese character set requires a Chinese version of Windows or a Chinese
emulator to properly display Chinese characters in the Text Display wizard. You must start the
Chinese emulator before you start the STEP 7--Micro/WIN software.

On the TD 200C and the TD 200, you can display up to 20 single-byte characters per line of your
message. Because Simplified Chinese uses double-byte characters, you can display up to 10
double-byte characters per line for a message in Chinese.

On the TD 100C, you can display up to 16 single-byte characters per line of your message.
Because Simplified Chinese uses double-byte characters, you can display up to 8 double-byte
characters per line for a message in Chinese.

The standard ASCII characters, such as numbers, punctuation, and upper and lowercase
alphabet characters, are available when using the Simplified Chinese character set. Depending
on your keyboard and/ or emulator, some of these standard characters may be formatted as
single-byte characters instead of the double-byte characters like the Simplified Chinese
characters. Standard ASCII characters and Chinese characters can be mixed on the TD display.

The Text Display wizard displays 8 or 10 double-byte character places for the text of a screen or
alarm. You can fit any of the following combinations into a character position:

1 double-byte character

2 single-byte characters (standard ASCII)

1 single-byte character and 1 single-byte blank

You cannot fit one single-byte character plus one double-byte character in a character position.

The TD 100C does not support the entire Simplified Chinese character set. The most-used
characters have been included in the TD 100C. See the Simplified Chinese Characters Set for a
list of supported characters. Characters that are not supported by the TD 100C are displayed as a
square (�).

Tip
The Simplified Chinese Character Set electronic file resides on the STEP 7--Micro/WIN
documentation CD. This file shows the characters supported by the different TD devices.



SIMATIC Text Display (TD) User Manual

100

Cyrillic Character Set

Table A-9 Cyrillic Character Set for the TD 100C, TD 200 and TD 200C



Technical Specifications and Reference Information Appendix A

101

Greek Character Set

Table A-10 Greek Character Set for the TD 100C, TD 200 and TD 200C
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Hebrew Character Set (TD 200C, TD 200 only)

Table A-11 Hebrew Character Set for the TD 200 and TD 200C
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Latin 1 Character Set

Table A-12 Latin 1 Character Set for the TD 100C, TD 200 and TD 200C
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Latin 2 Character Set

Table A-13 Latin 2 Character Set for the TD 100C, TD 200 and TD 200C
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Turkish (Latin 5) Character Set

Table A-14 Turkish Character Set for the TD 100C, TD 200 and TD 200C
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Connecting Multiple Devices on a
Network

You can connect multiple TD devices and S7-200 CPUs together on one communication network.
The TD devices act as network masters and do not interfere with each other. You can designate
the S7-200 CPUs to be either masters or slaves on the network.

In This Chapter
Communicating with Multiple CPUs 108. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Determining the Distances, Transmission Rate, and Cable 108. . . . . . . . . . . . . . . . . . . . . . . . . . .

Using Repeaters on the Network 109. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Selecting the Network Cable 109. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Biasing and Terminating the Network Cable 110. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Building a TD/CPU Cable 110. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Making a Cable That Supplies Power to the TD Device 111. . . . . . . . . . . . . . . . . . . . . . . . . .

Making a Cable That Does Not Supply Power to the TD 200
(TD 200C and TD 200 only) 111. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

CPU Grounding and Circuit Reference Point Guidelines for Using Isolated Circuits 112. . . . . .
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Communicating with Multiple CPUs
Figure B-1 shows a typical network with two TD 200s and two S7--200 CPUs. Each TD 200
communicates to one of the CPUs. The addresses of each device are noted below the device in
the figure. In this example:

TD 200 Number 1 is configured to communicate to the S7-200 CPU at address 2 (CPU 1)

TD 200 Number 2 is configured to communicate to the S7-200 CPU at address 3 (CPU 2)

Tip
You can connect multiple TD devices to a single S7-200 CPU. You can store separate
parameter blocks for each TD device in different V memory locations in the CPU.

If you do not store separate parameter blocks for each TD device that is connected to the CPU,
any of these TD devices can acknowledge the same messages and use function keys to initiate
operations in the CPU.

TD 200 (TD_1) CPU 224 (CPU_1)

TD 200 (TD_2)

CPU 224 (CPU_2)

Address 1

Address 4

Address 2

Address 3

To additional CPUs

Figure B-1 Typical Multiple CPU Network

Tip
The display time slows as more TD devices are added to the network.

Network connectors are available from Siemens. Using these connectors allows you to isolate the
CPUs from one another (the 24 VDC), but still allows you to power the TD device from the CPU.
See the SIMATIC S7-200 Programmable Controller System System Manual for more information
about using network connectors.

Determining the Distances, Transmission Rate, and Cable
As shown in Table B-1, the maximum length of a network segment is determined by two factors:
isolation (using an RS-485 repeater) and baud rate.

Isolation is required when you connect devices at different ground potentials. Different ground
potentials can exist when grounds are physically separated by a long distance. Even over short
distances, load currents of heavy machinery can cause a difference in ground potential.

Table B-1 Maximum Length for a Network Cable

Baud Rate Non-Isolated CPU Port1 CPU Port with Repeater or EM 277

9.6 kbaud to 187.5 kbaud 50 m 1,000 m

1 The maximum distance allowed without using an isolator or repeater is 50 m. You measure this distance from
the first node to the last node in the segment.
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Using Repeaters on the Network
An RS-485 repeater provides bias and termination for the network segment. You can use a
repeater for the following purposes:

To increase the length of a network: Adding a repeater to your network allows you to extend
the network another 50 m. If you connect two repeaters with no other nodes in between (as
shown in Figure B-2), you can extend the network to the maximum cable length for the
baud rate. You can use up to 9 repeaters in series on a network, but the total length of the
network must not exceed 9600 m.

To add devices to a network: Each segment can have a maximum of 32 devices connected
up to 50 m at 9600 baud. Using a repeater allows you to add another segment (32 devices)
to the network.

To electrically isolate different network segments: Isolating the network improves the quality
of the transmission by separating the network segments which might be at different ground
potentials.

A repeater on your network counts as one of the nodes on a segment, even though it is not
assigned a network address.

RS-485
Repeater

RS-485
Repeater

50 m 50 mUp to 1000 m

Segment Segment Segment

Figure B-2 Sample Network with Repeaters

Selecting the Network Cable
S7-200 networks use the RS-485 standard on twisted pair cables. Table B-2 lists the
specifications for the network cable. You can connect up to 32 devices on a network segment.

Table B-2 General Specifications for Network Cable

Specifications Description

Cable type Shielded, twisted pair

Loop resistance ±115 Ω/km

Effective capacitance 30 pF/m

Nominal impedance Approximately 135 Ω to 160 Ω (frequency =3 MHz to 20 MHz)

Attenuation 0.9 dB/100 m (frequency=200 kHz)

Cross-sectional core area 0.3 mm2 to 0.5 mm2

Cable diameter 8 mm ±0.5 mm



SIMATIC Text Display (TD) User Manual

110

Biasing and Terminating the Network Cable
Siemens provides two types of network connectors that you can use to easily connect multiple
devices to a network: a standard network connector and a connector that includes a programming
port (which allows you to connect a programming station or an HMI device to the network without
disturbing any existing network connections). The programming port connector passes all signals
(including the power pins) from the S7-200 through to the programming port, which is especially
useful for connecting devices that draw power from the S7-200 (such as a TD 200).

Both connectors have two sets of terminal screws to allow you to attach the incoming and
outgoing network cables. Both connectors also have switches to bias and terminate the network
selectively. Figure B-3 shows typical biasing and termination for the cable connectors.

A B A B A B A B

On On

A B A B

Off

Switch position = On
Terminated and biased

Switch position = Off
No termination or bias

Switch position = On
Terminated and biased

Cable must be terminated
and biased at both ends.

390 Ω

220 Ω

390 Ω

B

A

TxD/RxD +

TxD/RxD -

Cable shield

6

3

8

5

1

Network
connector

Pin #

B

A

TxD/RxD +

TxD/RxD -

Cable shield

A

BTxD/RxD +

TxD/RxD -
Cable shield

Bare shielding: approximately 12 mm (1/2 in.) must contact the metal guides of all locations.

6

3

8

5

1

Pin #
Switch position = Off:
No termination or bias

Switch position = On:
Terminated and biased

Figure B-3 Bias and Termination of the Network Cable

Building a TD/CPU Cable
The TD/CPU cable is used for connecting a display device to an S7-200 CPU. If you do not have
a TD/CPU cable, refer to Figures B-4 and B-5 to create your own cable.
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Making a Cable That Supplies Power to the TD Device

Caution
Connecting the 24 VDC power output (pin 7 of communication port) of multiple S7-200 CPUs
may cause erratic operation of the I/O, which could potentially cause personal injury and/or
property damage.

The 24 VDC power supply is also the sensor supply for the I/O. Interconnecting the output
power supplies of multiple CPUs could possibly overload the sensor supply, which could cause
the I/O to operate incorrectly.

When networking S7-200 CPUs, connect only the communication lines (pins 3, 5, and 8). You
must not connect the power output (pin 7).

Tip
The TD 100C must use the TD/CPU cable shown in Figure B-4.

Figure B-4 shows you the pin-out of TD/CPU cable with power supplied to the TD 200. Use this
option when you want the TD 200 to receive power from an S7-200 CPU.

24 VDC Return

Transmit/Receive Data +

24 VDC

Transmit/Receive Data --

24 VDC Return

Transmit/Receive Data +

24 VDC

Transmit/Receive Data --

Shield
1
2

3

4

5

6
7

8

9

1
2

3

4

5

6
7

8

9

TD 200 Side S7-200 Side

Figure B-4 TD/CPU Cable with Power Connections

Making a Cable That Does Not Supply Power to the TD 200 (TD 200C
and TD 200 only)

Figure B-5 shows you the pin-out of a TD/CPU cable without power supplied to the TD 200. Use
this option when you want the TD 200 to receive power from an external power supply. The
maximum length for the cable is 1200 meters.

Transmit/Receive Data +

Transmit/Receive Data --

Transmit/Receive Data +

Transmit/Receive Data --

1
2
3
4
5
6
7

8
9

TD 200 Side S7-200 Side

1
2
3
4
5
6
7

8
9

Shield

Figure B-5 TD/CPU Cable without Power Connections
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CPU Grounding and Circuit Reference Point Guidelines for
Using Isolated Circuits

The following items are CPU grounding and circuit guidelines for using isolated circuits:

You should identify the reference point (0 voltage reference) for each circuit in the
installation, and the points at which circuits with possibly different references can connect
together. Such connections can result in unwanted current flows that can cause logic errors
or can damage circuits. A common cause of different reference potentials is grounds that
are physically separated by long distances. When devices with widely separated grounds
are connected with a communication or sensor cable, unexpected currents can flow
through the circuit created by the cable and the ground. Even over short distances, load
currents of heavy machinery can cause differences in ground potential or can directly
induce unwanted currents by electromagnetic induction. Power supplies that are improperly
referenced with respect to each other can cause damaging currents to flow between their
associated circuits.

When you connect CPUs with different ground potentials to the same PPI network, you
should use an isolated RS-485 repeater.

S7-200 products include isolation boundaries at certain points to help prevent unwanted
current flows in your installation. When you plan your installation, you should consider
where these isolation boundaries are provided, and where they are not provided. You
should also consider the isolation boundaries in associated power supplies and other
equipment, and where all associated power supplies have their reference points.

You should choose your ground reference points and use the isolation boundaries provided
to interrupt unneeded circuit loops that could allow unwanted currents to flow. Remember to
consider temporary connections which may introduce a new circuit reference, such as the
connection of a programming device to the CPU.

When locating grounds, you must also consider safety grounding requirements and the
proper operation of protective interrupting devices.

In most installations, you will have the best noise immunity if you connect the CPU sensor
supply M terminal to ground.

The following descriptions are an introduction to general isolation characteristics of the S7-200
family, but some features may be different on specific products. Consult your product
specifications in the appropriate manual for information about which circuits include isolation
boundaries and the ratings of the boundaries. Isolation boundaries rated less than 1,500 VAC are
designed as functional isolation only, and should not be depended on as safety boundaries.

Logic circuit reference is the same as DC sensor supply M.

Logic circuit reference is the same as the input power supply M on a CPU with DC power
supply.

CPU communication ports have the same reference as logic circuit.

Analog inputs and outputs are not isolated from logic circuit. Analog inputs are full
differential to provide low voltage common mode rejection.

Logic circuit is isolated from ground to 500 VAC.

DC digital inputs and outputs are isolated from logic circuit to 500 VAC.

DC digital I/O groups are isolated from each other by 500 VAC.

Relay outputs are isolated from logic circuit to 1,500 VAC.

Relay output groups are isolated from each other by 1,500 VAC.

AC power supply line and neutral are isolated from ground, the logic circuit, and all I/O to
1,500 VAC.
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Troubleshooting

Refer to Table C-1 for a list of the problems that could occur with the TD device and possible
causes and solutions.

Table C-1 Error Messages

Problem Possible Cause Possible Solution

NO PARAMETER BLOCK The TD device could not find a
parameter block in the programmable
logic controller.

Configure a parameter block for the TD
device using the Text Display wizard,
and download it to the S7--200

Be sure the parameter block address in
the TD device matches the actual
address of the parameter block.

The TD device found a parameter block
in the programmable logic controller, but
it contains errors

Be sure all fields are within range

Be sure all addresses are valid for the
S7-200 CPU

No CPU COMM Address of the S7-200 CPU is incorrect Correct the address error

S7-200 CPU does not have power Power up the CPU

Cable problems Check the cable connections

Wrong baud rate configured Correct the baud rate configuration

Multiple CPUs at the same address Remove other CPUs and retry

May need network terminations Refer to Appendix B

Network too long or too many devices
on network

Refer to Appendix B

HARDWARE ERROR TD device is inoperable The TD device could be defective

Replace with a new TD device.

NETWORK ERROR

TD device cannot establish a

Multiple masters with the same
address.

Remove other masters and retry

TD device cannot establish a
network connection or enter an
existing network

Cable problems Check the cable connections
existing network

Multiple CPUs at the same address Remove the other CPUs and retry

CPU BUSY Some other master has locked the
S7-200 CPU by uploading or
downloading a program to that CPU

Wait — The message disappears in a
few seconds

CPU IN STOP MODE RUN/STOP switch is in STOP Put CPU in RUN mode

Display backlight is on, but no
message is displayed

Program checksum failure Defective hardware: Replace with a
new TD device

User cannot access the TD
system menus

The custom keypad does not contain
the ESC and ENTER buttons.

To restore the standard TD keypad:

1. Power down the TD device

2. Press and hold the lower right
corner (where ENTER key is
located on the standard keypad)

3. Power up the TD device

The default keypad is restored until the
TD device is power cycled again.
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Index
A

Accessing screens and alarms, Button descriptions,
64

Acknowledging an alarm, 72
Types of alarms, 55, 73

Adhering a custom faceplate, 20, 38
Alarms

Accessing the menus, 68
Acknowledging, 72
Alarm variables, 57
Button descriptions, 64
Configuring, 54–59
Default display mode, 7, 56, 71
Description, 7
Displaying, 72
Displaying alarms, 8
Displaying information, 66
Editing variables, 67, 75
Entering a password, 70
Parameter block, 7, 61
Priority, 72
Releasing a password, 70
TD Bit usage summary, 76
Types of alarms, 73

Approvals, USA and Canada, for, 93
Arabic character set, 97
ATEX guidelines, 92

B
Baltic character set, 98
Bar graph character set, 96
Baud rate, 83

Network, 108
Biasing, Network cable, 110
Brackets, mounting, TD 100C, 18
Buttons

Accessing screens, alarms, and menus, 68
Default display mode, 71
Descriptions, 64
Displaying information, 66
Editing variables, 67, 75
Keypad Designer

Adding, 29
Button template, 32
Deleting, 30
Erasing, 30
Modifying, 29
Panel image, 33
Properties, 30–32
Reversing the panel image, 34

Momentary contact, 48
Set bit, 48
Template, 32
Valid buttons, 30

C
Cable, 21, 90

Biasing, 110
Network, 108, 109
No power to TD 200, 111
TD 100C, 16
TD 100C order number, 90
TD/CPU Creating a pin-out, 110
Terminating, 110
To supply power to TD 200, 111

CE Symbol, 92
Certificates, Directives, Declarations, 92
Changing

Language set, 81
Operating mode of S7--200 CPU, 85
Time and date, 80

Character Set Error, troubleshooting, 113
Character sets

Arabic, 97
Baltic, 98
Bar graph, 96
Chinese, Simplified, 99
Cyrillic, 100
Greek, 101
Hebrew, 102
Latin 1, 103
Latin 2, 104
Simplified Chinese, 60, 99
Standard TD, 94
Supported, 4
Turkish (Latin 5), 105

Characters, special, ALT key combinations, 95
Chinese (Simplified), Character set, 60, 99
Communication, Multiple CPUs, 107
Components

Faceplate overlay (TD 100C), 16
Faceplate overlay (TD 200C), 16
Gasket, 16
Label insert (TD 200), 16
Mounting brackets, 16
Spacers, 16
TD/CPU cable, 16

Configuration
Alarms, 54–59

Types of alarms, 55
Default display mode, 56
Multiple CPUs, 107, 108
Multiple language sets, 59–61
Parameter block, 7, 61
Screens, 49–53

Alarm variables, 57
Screen text, 51
Screen variables, 51, 57
User menu, 50
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Subroutines, 61
Task overview, 9–11, 40–42
TD parameters, 42–47

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td2, *.td1), 47
Language set (primary), 46
Password, 44
Update rate, 46

Configuring the properties for the buttons, TD 100C,
TD 200C keypad, 30–32

Connecting the TD device, 21
Contrast of the display area, 83
CPU

Address, 83
Busy, troubleshooting, 113
Grounding and Circuit Point Guidelines, 112
Multiple CPU communication, 108
Not responding, troubleshooting, 113

Creating a TD/CPU cable, 110
Custom cable, 21
Custom faceplate

Dimensions, 20
Installation procedures, 20, 38
Keypad configuration file (*.td2, *.td1), 27, 34, 47
Panel image, 33
Reversing the panel image, 34
Tasks for creating a custom faceplate, 27
Templates, 23

Cyrillic character set, 100

D
Date and Time for the TD device, 80
Declaration of Conformity, 92
Default display mode, 7, 71
Diagnostic Menu, 82–87

Change Operating Mode, 85
Edit CPU memory, 86–88
Force I/O, 84
Make memory cartridge, 85
Setting up the TD device, 83
View messages, 84

Dimensions
Faceplate (TD 100C), 20
Faceplate (TD 200C), 20
Label insert (TD 200), 19
TD device, 17

Display backlight, troubleshooting, 113
Displaying information, 66

E
Editing the CPU memory, 86–88
Editing variables, 67, 75
Embedded String Variables, considerations, 53
EMC Directive, 92
Entering a password, 70
Error messages, Status of the S7--200 CPU, 78
Explosion protection guidelines, 92

Exporting
Button Template, 32
Panel image, 33

External power supply, 22

F
Faceplate

Dimensions (custom faceplate), 20
Installing a custom faceplate, 20, 38
Keypad configuration file (*.td2, *.td1), 27, 34, 47
Material, 13, 35–38
Material Order number, 13
Order number, 13
Panel image, 33
Reversing the panel image, 34
Standard TD keypad, 6, 64
Tasks for creating a custom faceplate, 27
Template file (A4), 12, 26
Templates, 23

Features, 3
Comparing TD devices, 5
Order number

Faceplate material, 13, 90
TD 100C, 90
TD 200, 90
TD 200C, 90

Floating--point numbers, 75
FM Approval, 93
Font size, TD 100C, 47
Forcing I/O, 84

G
Gap factor, 83
Gasket, 16, 18
Graphics application

Button template, 32
Panel image, 33

Greek character set, 101
Guidelines

CPU grounding and circuit reference point, 112
Setup, 92

H
Hardware

Order number
Faceplate material, 13, 90
TD 100C, 90
TD 200, 90
TD 200C, 90

Setting up the TD device, 83
Specification, 90
Task overview, 9–11

Hardware Error, troubleshooting, 113
Hebrew character set, 102
Hierarchy of menus, 68
Highest station, 83
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I
Importing, Panel image, 33
Installation

Components, 16
Connecting a TD 100C, 23
Connecting a TD 200C, 23
Custom cable, 21
Dimensions

Custom faceplate, 20
Label insert, 19
TD device, 17, 18

Installing a custom faceplate, 20, 38
Mounting a TD device, 17–19
Mounting brackets, 18
Order number

Faceplate material, 13
Faceplate material, 90
TD 100C, 90
TD 200, 90
TD 200C, 90

Power (TD/CPU cable), 22
Power supply, 22
Procedures and guidelines, 15–23
Spacers, 17
Task overview, 9–11
TD/CPU cable, 21

International characters, 95
Isolated circuits, Guidelines, 112
Isolation

Characteristics of S7--200 , 112
Network, 108

K
Keypad

Creating a custom keypad, 12, 26
Order number for faceplate material, 13
Panel image, 33
Restoring standard, 82, 113
Restoring standard TD, 23
Reversing the panel image, 34
Standard TD, 6, 64

Keypad configuration file (*.td2, *.td1), 27, 28, 34, 47
Keypad Designer

Buttons
Adding, 29
Button template, 32
Deleting, 30
Erasing, 30
Modifying, 29–31
Moving, 29
Panel image, 33
Properties, 30–32
Reversing the panel image, 34

Configuration file (Text Display wizard), 47
Dimensions (custom faceplate), 20
Faceplate template file, 12, 26
File types, 28
Installing a custom faceplate, 20, 38
Keypad configuration file (*.td2, *.td1), 27, 34, 47

Options, 28
Order number for faceplate material, 13
Overview, 12, 26
Printer requirements, 13
Saving, 34
Starting the application, 28
Tasks for creating a custom faceplate, 27
Templates, 23
Text Display wizard, 40–42
Tools (options), 28

Keys
Accessing screens, alarms, and menus, 68
Button descriptions, 64
Button template, 32
Displaying information, 66
Editing variables, 67, 75
Keypad Designer

Adding buttons, 29
Deleting buttons, 30
Erasing buttons, 30
Modifying buttons, 29
Properties, 30–32

Panel image, 33
Reversing the panel image, 34

L
Label insert (TD 200)

Dimensions, 19
Modifying, 19

Language set
Multiple, 59–61
Primary, 46
Switching languages, 81

Laser printer requirements, 13
Latin 1 character set, 103
Latin 2 character set, 104

M
Making, Cable to supply power to TD 200, 111
Making a cable, No power to TD 200, 111
Memory cartridge, 85
Menus

Accessing the menus, 68
Default display mode, 71
Diagnostic Menu, 82–87
Display Alarms, 72
Displaying information, 66
Editing variables, 67, 75
Hierarchy, 68
Operator Menu, 78–81

Messages
Accessing screens, alarms, and menus, 68
Displaying information, 66
Editing variables, 67, 75

Momentary contact, Buttons, 48
Mounting a TD device, 17–19

Spacers, 17
Multiple language sets, 59–61
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N
Network

Address, 83
Baud rate, 108
Biasing cable, 110
Cable, 108, 109
Calculating distances, 108
Connectors, 108
Isolation, 108
Repeaters, 109
Terminating cable, 110
Transmission rate, 108
Typical multiple CPU , 108

Network Error, troubleshooting, 113
No Parameter Block, troubleshooting, 113

O
Operation

Accessing screens, alarms, and menus, 68
Button descriptions, 64
Changing the language set, 81
Changing the operating mode of the S7--200

CPU, 85
Displaying information, 66
Editing the CPU memory, 86–88
Editing variables, 67, 75
Forcing I/O, 84
Making a memory cartridge, 85
Overview (screens and alarms), 8
Reviewing the configured messages, 84
Setting the time and date, 80
Setting up the TD device, 83
Types of alarms, 73
Viewing the status of the S7--200 CPU, 78

Operator Menu, 78–81
Changing the language set, 81
Setting the Time and Date, 80
View Status of the S7--200 CPU

Error messages, 78
Firmware version, 78

Order number
Faceplate material, 13, 90
TD 100C, 90
TD 200, 90
TD 200C, 90
TD/CPU cable, 90

P
Panel image, 33

Reversing for print, 34
Parameter block, 7, 9

Configuring the address in the TD device, 83
V memory address, 61

Password
Entering, 70
Releasing, 70

Pin-out, TD/CPU cable, 110
Power supply, 22

Primary language set, 46
Printer requirements, 13
Printing a custom faceplate, Creating a custom

faceplate, 27
Printing multiple faceplates, 13, 35–38

Template file, 12, 26
Printing the faceplate, Reversing the panel image,

34
Priority of alarms, 72
Product overview, 1–10

Backwards compatible, 15
Character sets, 4
Comparison TD devices, 5
Components, 16
Creating a custom keypad, 12, 26
Description, 2
Features, 3
Order number

Faceplate material, 13, 90
TD 100C, 90
TD 200, 90
TD 200C, 90
TD/CPU cable, 90

Printer requirements, 13
Standard TD keypads, 6, 64
Task overview, 9

PROFIBUS--DP network
Cable specifications, 108
Repeaters, 109

Properties of buttons (TD 100C, TD 200C), 30–32

R
Real numbers, 75
Releasing a password, 70
Repeaters, Network, 109
Restoring standard TD keypad, 23, 82, 113
Reversing the panel image, 34
Reviewing the configured messages, 84
RS--485 standard, 109

S
S7--200 CPU

Changing the operating mode, 85
Editing the CPU memory, 86–88
Error messages, 78
Firmware version, 78
General isolation characteristics, 112
Making a memory cartridge, 85
Model number, 78
Parameter block, 7
Supplying power to the TD device, 22

Screens
Accessing the menus, 68
Button descriptions, 64
Configuring, 49–53
Default display mode, 7, 56, 71
Displaying information, 66
Displaying screens, 8
Editing variables, 67, 75
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Entering a password, 70
Overview, 7
Parameter block, 7, 61
Releasing a password, 70
Screen variables, 51
Text message, 51
User menu, 50

Setting the time and date for the TD device, 80
Setup Guidelines, 92
Simplified Chinese, Character set, 60
Simplified Chinese character Set, 99
Simplified Chinese character set, 99
Spacers, 17
Special characters, 95
Specifications, 90–92
Standard TD

Character set, 94
Keypad, 23, 64
Restoring keypad, 23
Keypads, 6
Restoring keypad, 82
Restoring TD keypad, 113

STEP 7--Micro/WIN
Keypad configuration file (*.td2, *.td1), 27, 34, 47
Keypad Designer, 3
Starting the Keypad Designer, 28
Subroutines, 61
Task overview, 9–11
Text Display wizard, 3

Alarm variables, 57
Alarms, 54–59
Default display mode, 56
Parameter block, 61
Screen text, 51
Screen variables, 51
Screens, 49–53
User menu, 50

STR_CPY, using to create strings, 53
String variables, Embedded, 53
Summary, TD Bit Usage, 76
Switching the language set, 81

T
TD 100C

Accessing screens, alarms, and menus, 68
Alarms, 7
Cable, 90
Character sets, 4
Comparing TD devices, 5
Compatibility with other TDs, 15
Components, 16
Configuration tasks, 40–42
Contrast of the display, 83
Creating a custom keypad, 12, 26
Default display mode, 71
Description, 2
Dimensions, TD 100C, 18
Displaying alarms, 8
Displaying information, 66
Displaying screens, 8
Editing variables, 67, 75

Entering a password, 70
Establishing a connection, 23
Features, 3, 5
Font size, 47
Installation procedures, 15–23
Installing a custom faceplate, 20, 38
Keypad configuration file (*.td1), 27, 34, 47
Mounting brackets, 16
Order number

Faceplate material, 13, 90
TD 100C, 90

Parameter block, 7
Printer requirements, 13
Product overview, 1–13
Releasing a pasword, 70
Screens, 7
Set time and date, 80
Setup, 83
Specifications, 90
Standard configuration, 23
Standard TD keypad, 6, 64
Standard TD template, 23
Supplying power, 22
Task overview, 9–11
Tasks for creating a custom faceplate, 27
TD parameters, 42

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td1), 47
Language set (primary), 46
Password, 44
Update rate, 46

TD/CPU cable, 21
Templates, 23
Types of alarms, 55, 73

TD 200
Accessing screens, alarms, and menus, 68
Alarms, 7
Backwards compatible, 15
Changing the language set, 81
Character sets, 4
Comparing TD devices, 5
Components, 16
Configuration tasks, 40–42
Contrast of the display, 83
Default display mode, 71
Description, 2
Dimensions

Label insert, 19
TD 200, 17

Displaying alarms, 8
Displaying information, 66
Displaying screens, 8
Editing variables, 67, 75
Entering a password, 70
Features, 3, 5
Forcing I/O, 84
Installation procedures, 15–23
Modifying the label insert, 19
Mounting instructions, 17–19
Multiple language sets, 59–61
Order number, TD 200, 90



SIMATIC Text Display (TD) User Manual

120

Parameter block, 7
Product overview, 1–10
Releasing a password, 70
Reviewing the configured messages, 84
Screens, 7
Set time and date, 80
Setup, 83
Spacers, 17
Specification, 90–92
Standard TD keypad, 6, 64
Supplying power, 22
Task overview, 9–11
TD parameters, 42–47

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td2), 47
Language set (primary), 46
Password, 44
Update rate, 46

TD/CPU cable, 21
Types of alarms, 55, 73

TD 200C
Accessing screens, alarms, and menus, 68
Alarms, 7
Backwards compatible, 15
Changing the language set, 81
Changing the operating mode of the S7--200

CPU, 85
Character sets, 4
Comparing TD devices, 5
Components, 16
Configuration tasks, 40–42
Contrast of the display, 83
Creating a custom keypad, 12, 26
Default display mode, 71
Description, 2
Dimensions, TD 200C, 17
Displaying alarms, 8
Displaying information, 66
Displaying screens, 8
Editing the CPU memory, 86–88
Editing variables, 67, 75
Entering a password, 70
Establishing a connection, 23
Features, 3, 5
Forcing I/O, 84
Installation procedures, 15–23
Installing a custom faceplate, 20, 38
Keypad configuration file (*.td2), 27, 34, 47
Making a memory cartridge, 85
Mounting instructions, 17–19
Multiple Language sets, 59–61
Order number

Faceplate material, 13, 90
TD 200C, 90

Parameter block, 7
Printer requirements, 13
Product overview, 1–13
Releasing a password, 70
Reviewing the configured messages, 84
Screens, 7
Set time and date, 80

Setup, 83
Spacers, 17
Specifications, 90
Standard configuration, 23
Standard TD faceplate, 23
Standard TD keypad, 6, 64
Supplying power, 22
Task overview, 9–11
Tasks for creating a custom faceplate, 27
TD parameters, 42–47

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td2), 47
Language set (primary), 46
Password, 44
Update rate, 46

TD/CPU cable, 21
Templates, 23
Types of alarms, 55, 73

TD Bit Usage summary, 76
TD/CPU cable, 16, 21

Creating a pin-out, 110
Template for printing multiple faceplates, 12, 26

Printer requirements, 13
Templates, Standard TD keypad, 23
Terminating, Network cable, 110
Text Display wizard

Alarm variables, 57
Alarms, 54–59
Default display mode, 56
Multiple language sets, 59–61
Parameter block, 61
Screen text, 51
Screen variables, 51
Screens, 49–53
Subroutines, 61
Task overview, 40–42
TD parameters, 42–47

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td2, *.td1), 47
Language set (primary), 46
Password, 44
Update rate, 46

User menu, 50
Time and Date for the TD device, 80
Transmission rate, Network, 108
Troubleshooting, TD 200, 113
Turkish (Latin 5) character set, 105
Types of alarms, 55, 73

U
Unforcing I/O, 84
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V
V memory address for the parameter block, 61
Valid buttons, Description, 30
Variables, Editing values, 67, 75
View status of the S7--200 CPU

Error messages, 78
Firmware version, 78

Viewing the configured messages, 84

W
Wizard

Configuring the alarm variables, 57
Configuring the alarms, 54–59
Configuring the screen text, 51

Configuring the screen variables, 51
Configuring the screens, 49–53
Configuring the user menu, 50
Default display mode, 56
Parameter block, 61

Wizard (TD configuration)
Multiple language sets, 59–61
Task overview, 40–42
TD parameters, 42–47

Button functionality, 48
Device, 43
Enabling TD menu functions, 44
Keypad configuration file (*.td2, *.td1), 47
Language set (primary), 46
Password, 44
Update rate, 46
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✄

To

SIEMENS ENERGY & AUTOMATION INC

ATTN: TECHNICAL COMMUNICATIONS

ONE INTERNET PLAZA

PO BOX 4991

JOHNSON CITY TN USA 37602--4991

From

Name: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Job Title: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Company Name: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Street: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

City and State: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Country: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Telephone: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

Please check any industry that applies to you:

❒ Automotive

❒ Chemical

❒ Electrical Machinery

❒ Food

❒ Instrument and Control

❒ Non-electrical Machinery

❒ Petrochemical

❒ Pharmaceutical

❒ Plastic

❒ Pulp and Paper

❒ Textiles

❒ Transportation

❒ Other ___________________________
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Additional comments:
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_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _
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Please give each of the following questions your own personal mark within a range from 1 (very
good) to 5 (very poor).

1. Do the contents meet your requirements?

2. Is the information you need easy to find?

3. Is the text easy to understand?

4. Does the level of technical detail meet your requirements?

5. Please rate the quality of the graphics and tables.

Remarks Form

Your comments and recommendations will help us to improve the quality and usefulness of our
publications. Please take the first available opportunity to fill out this questionnaire and return it
to Siemens.


	Title
	Preface
	Contents
	Ch1 Product Overview
	Introducing the S7- 200 Text Display (TD) Devices
	Features of the TD Devices
	International Languages and Characters Support

	Comparing the TD 100C, the TD 200 and the TD 200C
	Using the TD Device to Access Screens and Alarms
	Dividing Information into Screens and Bit- Enabled Alarms

	Installation and Configuration Tasks
	Creating a Custom Faceplate for The TD Device
	Printing the Custom Faceplate for the TD Device
	Printer Requirements
	Ordering Additional Faceplate Material


	Ch2 Installing Your TD Device
	Components Shipped with the TD Devices
	Mounting the TD 200C and TD 200 in a Panel or on a Surface
	Preparing the Mounting Surface for a TD 200C or TD 200
	Preparing the TD 200C and TD 200 for Mounting
	Positioning the Spacers for the TD 200C and TD 200
	Mounting the TD 200C and TD 200

	Mounting the TD 100C in a Panel or on a Surface
	Preparing the Mounting Surface for a TD 100C
	Mounting the TD 100C

	Customizing the Labels for the Keys of the TD 200
	Modifying the Label Insert of the TD 200
	Creating a Custom Label Insert for the TD 200

	Installing a Faceplate for the TD 100C and the TD 200C
	Connecting the TD/CPU Cable
	Supplying Power for the TD Device
	Establishing a Connection for Your TD Device
	TD 100C and TD 200C


	Ch3 Using the Keypad Designer to Create a Custom Faceplate for Your TD Device
	Using the Keypad Designer with Other Applications
	Starting the Keypad Designer
	Adding Buttons to the Keypad
	Inserting a Button
	Modifying the Shape of a Button

	Defining the Properties of the Button
	Exporting the Keypad Layout to a Graphics Application
	Adding a Panel Image to the Faceplate
	Importing a Panel Image

	Saving the Keypad to a TD Configuration File
	Reversing the Panel Image
	Printing the Panel Image on a Faceplate
	Printing a Single Faceplate from the Keypad Designer
	Printing the Faceplate from a Word- Processing Application

	Installing the Printed Faceplate onto the TD device

	Ch4 Using the Text Display Wizard to Configure the S7- 200 CPU for Your TD Device
	Overview of the Configuration Tasks
	Configuring the TD Device
	Task Overview
	Starting the Text Display Wizard for the TD Device
	Selecting the Type of TD Device to Configure
	Selecting a Password for the TD Device
	Enabling the TD Menu Functions
	Selecting the Update Rate for the TD Device
	Selecting the Language and the Character Set
	Selecting the Font Size (TD 100C only)
	Loading a Custom Keypad (TD 100C and TD 200C Only)
	Configuring the Buttons on the Keypad

	Configuring the Screens for the TD Device
	Creating the User Menu
	Creating the Text for a Screen
	Embedding a Variable into the Text of a Screen

	Configuring the Alarms
	Determining the Type of Operator Interaction for an Alarm
	Setting the Default Display Mode and Alarm Parameters
	Entering the Text for an Alarm
	Embedding a Variable into the Text of an Alarm

	Configuring the Language Sets for the TD Device ( TD 200C, TD 200 only)
	Notes for Using the Simplified Chinese Character Set

	Assigning the V Memory Address for the Parameter Block
	Finishing the Configuration for the TD Device

	Ch5 Operating Your TD Device
	Using the TD Device to Access Screens and Alarms
	Displaying Information on the TD Device
	Using the TD Device to Edit Variables in the S7- 200 CPU

	Accessing the Menus and Screens
	Entering and Releasing a Password
	Entering the Password
	Releasing the Password

	Viewing the Screens and the Alarms
	Displaying the Alarms
	Clearing an Alarm
	Editing a Variable that is Embedded in an Alarm or a Screen
	TD Bit Usage

	Performing Typical or Routine Operator Tasks
	Viewing the Status of an S7- 200 CPU
	Setting Time and Date in the S7- 200 CPU
	Changing the Language Set (TD 200C and TD 200 only)
	Cleaning the Keypad

	Performing Specialized Operator Tasks (Diagnostic/Setup Menu)
	Setting up the TD Device
	Viewing the TD Messages Stored in the S7- 200 CPU ( TD 200C, TD 200 only)
	Forcing the Inputs and Outputs in the S7- 200 CPU ( TD 200C, TD 200 only)
	Changing the Operating Mode of the S7- 200 CPU (TD 200C Only)
	Copying the User Program to a Memory Cartridge (TD 200C Only)
	Editing the CPU Memory (TD 200C Only)


	AppA Technical Specifications and Reference Information
	General Technical Specifications
	Certificates, Directives and Declarations
	IEC 61131-- 2
	Notes on the CE Symbol
	EMC Directive
	ATEX Directive (Explosion Protection Guidelines)
	Declaration of Conformity
	Observing the Setup Guidelines

	Approvals for USA, Canada and Australia
	FM Approval Notes

	Standard TD Character Set (TD 200C, TD 200 only)
	ALT Key Combinations for International and Special Characters
	Bar Graph Character Set (TD 200C, TD 200 only)

	Arabic Character Set (TD 200C, TD 200 only)
	Baltic Character Set
	Simplified Chinese Character Set
	Notes for Using the Simplified Chinese Character Set

	Cyrillic Character Set
	Greek Character Set
	Hebrew Character Set (TD 200C, TD 200 only)
	Latin 1 Character Set
	Latin 2 Character Set
	Turkish (Latin 5) Character Set

	AppB Connecting Multiple Devices on a Network
	Communicating with Multiple CPUs
	Determining the Distances, Transmission Rate, and Cable
	Using Repeaters on the Network
	Selecting the Network Cable
	Biasing and Terminating the Network Cable

	Building a TD/CPU Cable
	Making a Cable That Supplies Power to the TD Device
	Making a Cable That Does Not Supply Power to the TD 200 (TD 200C and TD 200 only)

	CPU Grounding and Circuit Reference Point Guidelines for Using Isolated Circuits

	AppC Troubleshooting
	Index

